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About This Guide 

This guide provides instructions for installing and 
operating BTOS OFIS® Imager, a software product that 
enables you to scan photographs, pictures, and other 
images from outside sources for the purposes of editing, 
printing, or incorporating them into OFIS Designer text. 

BTOS OFIS Imager hereafter shall be referred to as 
OFIS Imager. 

Who Should Use This Guide 

This guide was written for both novice and experienced 
BTOS operators. You must be familiar with the BTOS 
operating system and somewhat knowledgeable about 
operating a graphics product with a mouse to learn 
OFIS Imager. 

How This Guide Is Organized 

This guide is organized into the following sections: 
o Section 1 provides an overview of OFIS Imager and 

defines operating system software as well as hardware 
requirements for proper use of the product. 

v 

o Section 2 explains how to install OFIS Imager onto your 
workstation and how to operate the mouse. 

o Section 3 discusses all procedures you must follow to 
use OFIS Imager, including step-by-step instructions 
for preview and final scanning, editing an image, and 
printing an image or incorporating an image into an 
OFIS Designer file. 

o Section 4 is a command and function quick-reference 
tool which you can use when you become more familiar 
with OFIS Imager operations. 

OFIS is a registered trademark of Unisys Corporation. 
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vi About This Guide 

Reference Material 

This guide includes a glossary, an index, and two 
appendixes. Appendix A lists and explains Error Codes and 
Messages specific to OFIS Imager; these messages can also 
be found in the BTOS II System Status Codes Reference 
Manual. Appendix B provides useful information for 
configuring OFIS Imager using the User Configuration File, 
and for configuring Context Manager to effectively run 
with OFIS Imager. 

Text Conventions 

Except in tables, this guide presents the following terms in 
boldface (heavier type): Commands, function and other key 
labels, form and menu field names, and entries you type in 
fields. 

Menu field names appear with initial capital letters; for 
example, Create. 

Keyboard keys are labeled in all capital letters; for 
example, GO and MARK. 

This guide uses the following expressions and terms: 
o When two keys are used together for an operation, they 

are hyphenated. For example, CODE-SHIFT means that 
while you hold down CODE, you press SHIFT. 

o Character refers to alphanumeric symbols, and to 
spaces (blanks) you enter by pressing the Spacebar. 

Related Product Information 

For information regarding BTOS OFIS Designer as it 
relates to OFIS Imager, refer to the BTOS OFIS Designer 
Operations Guide, Volume 3: Advanced Operations and the 
BTOS OFIS Designer Installation, Configuration, and 
Administration Guide. 

For information about the printers used for OFIS Imager 
output, refer to the BTOS Generic Print System (GPS) 
Installation and Administration Guide. 

For an explanation of other BTOS operations and BTOS 
executive commands, refer to the BTOS II System 
Reference Manual and the BTOS II Standard Software 
Operations Guide. 
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Section 1 1-1 

Overview 

OFIS Imager is a software program you can use to transfer 
an image on paper into electronic form. You can scan 
anything that lies flat, from line art to photographs and 
drawings that contain shading. From there you can edit 
these images on your screen, and integrate them into 
documents. 

With OFIS Imager, you can also store images you scan, 
such as an important logo or useful photograph, for use at 
a later date. You can attach scanned images to electronic 
mail messages and transfer them to any location on a 
network. 

Figure 1-1 shows a document containing an image created 
using OFIS lmager. The image was created first by 
scanning a photograph from paper, then editing it using the 
resizing functions, and finally integrating it into an existing 
document using the transferring procedure. 

Figure 1-1 Image Scanned with OFIS lmager 
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1-2 Overview 

Hardware Requirements 

To use OFIS Imager, you must have a B28, B38, or B39 
graphics workstation with the following: 
o color or monochrome monitor 
o hard disk either at the workstation or at the master 
o 5-1/4 inch floppy disk drive 
o two-button or three-button mouse 
o one of the following scanners, if you intend to scan 

images from a scanner rather than from files: 
the Microtek MS-300A serial interface scanner (for use 
with any workstation) 
the HP Scanjet parallel interface scanner (for use only 
with a workstation that has a bidirectional parallel 
interface port; for example, a B28EV, B38EV or B39 
workstation) 

Note: OFIS lmager scanners require special cables. Contact 
your Unisys representative for more information and ordering 
procedures. 

o GPS-supported printer, if you intend to print images 
alone or OFIS Designer documents that contain images 
For more information on printers, refer to the BTOS 
Generic Print System (GPS) Installation and 
Administration Guide. 

o one of the following: 
B25GRA graphics module 
B28AG2 

contains B25AG2 Hardware module and B28-AST 
software 

B38AG2 
contains B25AG2 Hardware module and B38-AST 
software 

B39AG1 
contains B39AG 1 Hardware card and B39-AST 
software 



Overview 

Memory Requirements 

OFIS lmager requires the following memory to run 
properly: 
o approximately 925 sectors of disk space 
o at least 500 Kb of workstation system memory 

1-3 

o at least 3500 sectors of scratch disk space for the 
default bitmap of 300 dpi. (You need 11500 sectors of 
scratch disk space if you plan to create the largest size 
bitmap of 600 dpi.) 

Software Requirements 

You must have the following software to use OFIS Imager: 
o OFIS Imager software 
o BTOS II 1.0 or higher; BTOS II 2.0 or higher if using 

the HP Scanjet scanner 
o Mouse System Service (not packaged with BTOS II 1.0) 
o Generic Print System (GPS) 2.0 (if printing) 
o OFIS Designer 2.0 or higher (if integrating images into 

documents) 

You may choose to run BTOS Context Manager™II 1.0 or 
higher with OFIS Imager. Context Manager is an 
application utility which allows you to switch between 
contexts without having to finish out of sessions within 
these contexts. For information on configuring Context 
Manager refer to appendix B. For additional information 
refer to your Context Manager documentation. 

Context Manager is a trademark of Convergent, Inc. 
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Section 2 2-1 

Installing OFIS lmager 

OFIS Imager is packaged on a 5-1/4 inch diskette. You can 
install this software on your workstation or on an XE520 
unit. 

Installing OFIS lmager on a 
Workstation 

To install OFIS Imager on a standalone, cluster, or 
master workstation, use the following procedure: 

1 Insert the product diskette into floppy disk drive [fO]. 

2 From the Executive Command line, choose one of the 
following procedures: 

o To install OFIS Imager on the [Sys]<Sys> path of 
the workstation, enter Software Installation. 

D To install OFIS Imager to a specific directory, enter 
Software Installation and complete the following 
steps: 
1 Press RETURN. 
2 Enter the full path name as [volume]<directory> 

in the [Files to] field. 
3 Press GO. 
4 Follow the prompts that appear to complete the 

software installation. 

Installing OFIS lmager on an XE520 

To install OFIS Imager on an XE520 unit, use the 
following procedure: 

1 Insert the product diskette into floppy disk drive [fO] of 
your standalone, cluster, or master workstation. 

2 Enter XESoftware Installation on the Executive 
Command line. 

3 Press GO. 
4 Follow the prompts that appear to complete the 

software installation. 
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2-2 Installing OFIS lmager 

Installing Related Software 

To install Generic Print System (GPS) 2.0, 
OFIS Designer 2.0 or higher, and Context Manager II 1.0 
or higher, refer to each product's appropriate 
documentation for instructions. 

If you choose to install Context Manager, refer to 
appendix B, which contains information useful for 
configuring Context Manager to run OFIS lmager. 

Installing and Configuring the Mouse 

To install Mouse hardware and software, refer to the 
BTOS II Standard Software documentation. 

To configure the mouse, attach it to either the right or left 
port of your keyboard. You can use the Set Mouse Controls 
command to change the mouse cursor speed and type. 

Operating the Mouse 

You use the two-button mouse (shown in figure 2-1) or 
three-button mouse (shown in figure 2-2) to move the 
cursor and select commands in OFIS Imager. The mouse 
has two or three buttons with the following functions: 
o Mark (left button) 

The Mark button allows you to select icons and choose 
images to scan. 

o Bound (right button) 
The Bound button allows you to dismiss a scan box or 
resize a zoom box. 

o Quick Menu (middle button) on your three-button 
mouse. If you have a two-button mouse, you press 
CODE-M to access the Quick Menu. 
The Quick Menu button or pressing CODE-M allows 
you to lock or unlock the edit box while you are 
working from the Edit menu. 

Note: Unwanted boxes may appear on the OFIS lmager screen 
if you press the MARK and BOUND keys on the keyboard. You 
can remove unwanted boxes by clearing each one using the 
Bound button on the mouse or by toggling the Layout mode. 



Installing OFIS lmager 2-3 

Figure 2-1 Two-Button Mouse 

Mark 
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2-4 Installing OFIS lmager 

Figure 2-2 Three-Button Mouse 

Mark 

To practice moving the mouse (and, therefore, the mouse 
cursor), display the OFIS Imager screen, as shown in 
section 3. With the screen displayed, move the mouse on 
your desktop and watch the arrow, referred to as the 
mouse cursor, on the screen. Notice that movement of the 
mouse cursor on the screen corresponds directly to 
movement of the mouse. The mouse cursor moves in the 
same direction as the mouse and with the same speed. You 
can use the Set Mouse Controls command to change the 
mouse cursor speed and type. 



Installing OFIS lmager 2-5 

There are three terms you should be familiar with as you 
work with the mouse buttons: 
o Click 

Click means to press and release a mouse button. 
o Drag 

When you drag the mouse, you press and hold a button 
while you move the mouse. By holding down the Mark 
button and moving the mouse, you can, for example, 
define or resize a scan box. 

o Select 
To Select an icon or function key means to move the 
mouse cursor to the icon or function key and click the 
Mark button. 

Using the Mouse to Define, Position, 
and Size the Scan Box 

When using OFIS Imager, you work with several types of 
boxes. Most often you define, position, and size the Scan 
Box, which positions and sizes the images you scan. 

To practice defining, positioning and sizing the scan 
box, use the following procedure: 

1 With the OFIS Imager screen displayed (refer to 
section 3), press and hold the Mark button. Drag the 
mouse in a way which forms a box on the screen. (Note 
how scan boxes are simultaneously formed in both work 
areas.) 

2 Release Mark. Note how the scan box is actually an 
arrangement of rectangular handles, with the outer 
handles connected by thin lines. These handles are used 
in moving and sizing the scan box. 

3 To move (position) the scan box, move the mouse cursor 
to the middle handle inside the box, press and hold 
Mark and drag the mouse. 

4 To resize the scan box, move the cursor to one of the 
outside handles, press and hold Mark and drag the 
mouse. 

5 To remove the scan box, click Bound. 
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Section 3 3-1 

Using OFIS lmager 

This section tells you how to use OFIS Imager: Topics 
covered include: 
o starting OFIS Imager 
o the OFIS Image,r screen 
o customizing OFIS Imager 
o choosing a printer 
o using the Help function 
o scanning an image into the preview and final work 

areas 
o modifying the view of an image 
o modifying an image 
o filing and printing images 
o finishing an OFIS Imager session 
o incorporating an image into an OFIS Designer document 

After you read this section, you will know enough about 
OFIS lmager to be able to practice scanning artwork and 
editing it for final output. 

Starting OFIS lmager 

You can start OFIS Imager from the Executive, Context 
Manager, or OFIS Designer. By starting OFIS Imager as a 
cooperating program from OFIS Designer, you can 
incorporate images in your OFIS Designer documents. The 
methods of starting OFIS Imager are described in the 
following paragraphs. 
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3-2 Using OFIS lmager 

Starting OFIS lmager from the Executive 

To start OFIS Imager from the Executive, use the 
following procedure: 

1 Enter OFIS lmager at the Executive Command line. 
2 Choose one of the following: 

o Press GO to load OFIS Imager. 
o Press RETURN to specify an image file which will 

appear in the OFIS Imager Final Work Area. 
Specify the image file name at the [Image file) 
parameter, and press GO. 

Starting OFIS lmager from Context Manager 

To start OFIS Imager from Context Manager, use the 
following procedure: 

1 Select OFIS Imager from the Applications You Can 
Start box. 

2 Press GO. 

Starting OFIS lmager from OFIS Designer 

To start OFIS Imager from OFIS Designer, use the 
following procedure: 

1 Press MARK to select an anchor character. 
2 Select the Utility (F7) function key. 
3 Press the number that corresponds to OFIS Imager. 

An arrow appears briefly on the screen along with a 
message that displays the version of the OFIS Imager 
software. The OFIS Imager screen then appears. 
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The OFIS lmager Screen 

The OFIS Imager screen, shown in figure 3-1, consists of 
two work areas and several menus. You scan images into 
either of the work areas; the menus display the tools and 
options you can choose to define and modify the images. 
The ruler areas displayed at the top and left side of each 
work area are useful for scaling the scan box and the 
images you ultimately define. 

Figure 3-1 The OFIS lmager Screen 
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Two Work Areas 

The OFIS Imager screen consists of two work areas, the 
Preview Work Area on the left portion of the screen and 
the Final Work Area in the middle of the screen. Often, the 
two work areas are used together when you scan an image 
into the Preview Work Area and then scan it into the Final 
Work Area for editing and eventual output. However, you 
can scan images directly into the Final Work Area (this 
procedure is discussed later). 

You can consider the Preview Work Area as a place to 
temporarily view an image currently in the scanner, and 
the Final Work Area as the place for processing the image. 

Picture Tabs 

Picture tabs appear at the top of the OFIS Imager screen. 
One of these picture tabs is always highlighted to indicate 
the active work area (the area you are currently working 
within). OFIS Imager commands apply only to the image in 
the active work area, and the editing tools function only in 
the Final Work Area. The picture tab for the Preview Work 
Area displays the name of the image or file the area 
contains (if the image has a name). 

Layout Icon 

The Layout Icon appears between the picture tabs. You use 
this icon to change the screen from Dual Layout to Single 
Layout. When you start OFIS Imager, the screen defaults 
to Dual Layout, which means that both work areas are 
displayed. Using the Layout Icon, you can change the 
screen to Single Layout and display more of the active 
work area (refer to the information under Using Single 
Layout in this section). 
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OFIS lmager Menus 

You use several menus in OFIS Imager to scan and edit 
images. Many of the tools used in the scanning and editing 
procedures display as icons in the Scan and Edit menus 
along the right side of the screen. 

The Function Menu 

The Function menu, displayed along the bottom of the 
screen, contains boxes that correspond to the function keys 
(Fl through FIO) on your keyboard (refer to figure 3-2). 
Some function keys directly execute commands, such as 
F8 (Cancel) and FlO (Go), while others display menus, 
such as F3 (Set Up) and F4 (Files). There are two ways to 
select a function key: 
o You can use the mouse to move the cursor to the 

Function menu and click Mark. 
o You can press the appropriate keyboard function key. 

Figure 3-2 The Function Menu 

The Scan and Edit Menus 

The Scan menu and the Edit menus are located along the 
right side of the screen (refer to figure 3-3). When you 
start OFIS Imager, the Scan menu is displayed. You use the 
Scan menu to adjust the scanning environment and to scan 
images. Once you scan an image into the Final Work Area, 
you use the Edit menu to modify the image. You use the 
More icon ellipsis to switch back and forth between the 
two menus. 
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Figure 3-3 The Scan and Edit Menus 
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Selecting Tools and Functions 

You choose tools from the Scan and Edit menus, and you 
select functions from the Function menu. You use the 
mouse to select tools and either the mouse or the function 
keys to select functions. 

To select a tool or function using the mouse: 

1 Move the cursor to the tool or function. 
2 Click the Mark button. 

When you choose a tool, its icon is highlighted. When you 
select a function, either the operation is executed, or a 
pop-up menu is displayed. Three of the selections on the 
Scan menu also display pop-up menus: Output Device, Scan 
Size, and Photo Mode. Four of the function keys display 
pop-up menus. 

· Pop-Up Menus 

When selected, some tools and functions display pop-up 
menus. These menus contain options relevant to that 
particular tool or function. For example, the Files pop-up 
menu (F4) contains three filing-related options, while the 
Output Device pop-up menu lists the names of the 
available printers. 

To make a choice from a pop-up menu, use the 
following procedure: 

1 Select the menu or function title to display the pop-up 
menu. 

2 Use the mouse to highlight an option.and click Mark. 

If the option is a command, the command is executed. 
Otherwise, the option is selected; for example, a printer 
from the Output Device menu. 

To close a pop-up menu without making any selections, 
select Cancel (F8) on the Function menu, or click Bound 
on the mouse. Otherwise, the pop-up menu is removed 
from the screen when you select another option or select 
Go. 
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Canceling Commands 

If you change your mind about a command or experience 
problems while executing a command, select or press 
Cancel (FS). Cancel gets you out of most situations and 
puts you back where you started. For example, you can 
select Cancel to stop printing, to remove a pop-up menu, 
or to remove a text entry line, such as the one that appears 
when you choose Get Image from the Files pop-up menu. 

Getting Help 

The Help icon, located at the lower right corner of the 
screen, displays a brief description of each tool. 

To use Help, use the following procedure: 

1 Move the cursor to the Help icon (the icon labeled?) 
and click Mark, or press the HELP key on the 
keyboard. 

2 Move the cursor, which now looks like a question mark, 
to the tool or function you want described, and click 
Mark. 

To exit Help, use the following procedure: 

1 Move the cursor to the Help icon and click Mark, or 
select Cancel (FS). 

Note: For more information on any of the tools, functions, and 
features mentioned in this section, refer to the appropriate entry 
in section 4. 

Mail Notification 

If your system uses electronic mail, OFIS Imager notifies 
you when you have received mail by displaying a small 
envelope at the top left corner of the screen. If the mail is 
urgent, the Envelope icon displays in reverse video on a 
monochrome monitor and red on your color monitor. 
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Customizing OFIS lmager Using the 
Set Up Menu 

3-9 

By choosing the Set Up menu (F3), you can alter the 
behavior of OFIS Imager. The Set Up menu consists of the 
following options: 
o Mouse Hand, which changes the function of the mouse 

buttons so that the mouse can be either a right-handed 
or left-handed device 

o Output Paper, which defines your output paper size 
o Custom Height and Custom Width, which specify the 

size of the paper you use for printing an image, if you 
chose Custom Output Paper from the Output Paper 
option 

o X Resolution and Y Resolution, which change the 
settings for image resolution 

o Units, which alters the ruler units in the ruler areas on 
the screen 

o TIFF File Formats, which changes the format that 
OFIS Imager uses to save images 

Choosing a Printer 

Before you start a session with OFIS Imager, you should 
use the Output Device pop-up menu to choose an output 
device, the printer that you use to print the final image. 
The printer you select determines the resolution of the 
image you scan. 

To choose a printer, use the following procedure: 

1 From the Scan menu, select Output Device. 
2 Move the cursor to the printer name and click Mark. 

The name of the printer is displayed below Output 
Device on the Scan menu, and all images print to this 
device during the rest of the OFIS Imager session. 

If your system is part of a network, there may be a delay 
before OFIS Imager recognizes available output devices, 
and the message No Graphics Device were found on the 
system (7700) may result when you select Output Device. 
To avoid this, you can make an entry in your user 
configuration file that causes the system to choose a 
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default printer each time you start an OFIS lmager session. 
For more information, refer to appendix B. 

Scanning an Image into the Preview 
Work Area 

Although you have the option of scanning images in the 
scanner directly into the Final Work Area, you should 
consider first scanning such images into the Preview Work 
Area. Doing so takes little time, gives you an idea of what 
the original image looks like in the scanner, and enables 
you to choose all or part of the image for the final scan. 

Images are grouped into two basic types: line art and 
photograph (refer to figure 3-4). Line art is a term for 
images that are primarily black and white (or green on a 
monochrome monitor) and that contain little or no shading. 
Photographs are images that contain continuous shading. 
Two OFIS Imager icons allow you to specify the type of 
image you intend to scan: 
o the tiger on the left for line art 
o the tiger on the right for photographs 

When you select the Photograph icon, you can choose a 
more specific type of photo. For more information refer to 
subsection Photo Mode in section 4. 
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Figure 3-4 Line Art and Photograph 
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Previewing Line Art 

To preview line art (scan line art into the Preview Work 
Area), use the following procedure: 

1 Place the paper containing the image you want scanned 
into the scanner. 

2 Move the cursor to the picture tab above the Preview 
Work Area and click Mark. 
The Preview Work Area is now the active work area, 
and its picture tab is highlighted. 

3 To adjust the brightness of the image, move the cursor 
to one of the Brightness options on the Scan menu and 
click Mark. 
The Brightness options nearer the left end of the scale 
darken the image, whereas the options nearer the right 
end lighten the image. 

4 From the Scan menu, select the Line Art icon (refer to 
figure 3-5). 

5 Select the Scan icon (refer to figure 3-6). 

Figure 3-5 Line Art icon 

Line Art 
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Figure 3-6 Scan icon 
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The scanner scans a low-resolution image of the line art 
and displays that version in the Preview Work Area of the 
screen. If the Preview Work Area does not display what 
you want (that is, if the image appears upside-down or 
crooked), simply repeat steps 1 through 5 above after 
adjusting the paper containing the image. 

Once you have scanned a line art image into the Preview 
Work Area, you need to scan it into the Final Work Area 
for editing and eventual output or filing. If you are 
working only with line art, skip to the information in this 
section under Scanning an Image into the Final Work Area. 

Previewing Photographs 

The term photograph refers to any image that contains 
continuous shading. OFIS Imager has several options you 
can use to simulate the shading in photographs or colors in 
drawings. These options are contained in the Photo Mode 
menu. 

Choices in the Photo Mode menu include Photocopy and 
Laser; the number and types of choices depend on the 
scanner you are using. In general, Photocopy simulates 
shading in such a way that it reproduces well on a 
photocopy machine. (You can use any of the other settings 
in the menu and still photocopy the result, but Photocopy 
usually gives the best result.) On the other hand, if you 
want to print an image on a laser printer, the Laser setting 
usually gives the best result. 

For more detailed information on the fine-tuning options 
under Photo Mode, refer to the subsection on Photo Mode 
in section 4. 
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To preview photographs (scan photographs into the 
Preview Work Area), use the following procedure: 

1 Place the paper containing the image you want scanned 
into the scanner. 

2 Move the cursor to the picture tab above the Preview 
Work Area and click Mark. 

3 Adjust the brightness of the image by moving the cursor 
to one of the Brightness options on the Scan menu and 
clicking Mark. To darken the image, select an option 
nearer the left side; to lighten the image, select an 
option closer to the right end of the scale. 

4 From the Scan menu, select the Photograph icon (refer 
to figure 3-7). OFIS Imager simulates shading in the 
photograph. 

5 Move the cursor to Photo Mode and click Mark. 
The Photo Mode pop-up menu is displayed. As 
explained earlier, the settings in this menu are designed 
to provide the best shading for the type of input you've 
chosen and the type of output you desire. For example, 
if you plan to eventually print the image on a laser 
printer, choose a Laser option. 

6 Move the cursor to your choice and click Mark. 
The box to the left of the choice is highlighted, the 
menu disappears, and your choice is displayed below 
Photo Mode on the Scan menu. 

7 Select the Scan icon (refer to figure 3-6). 

The scanner scans a low-resolution image of the 
photograph and displays that version in the Preview Work 
Area of the screen. If the Preview Work Area does not 
contain the image you expected (for example, if the image 
is upside-down or crooked), repeat steps 1 through 7 
above. 

Figure 3-7 Photograph Icon 

Photograph 
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Scanning an Image into the Final Work 
Area 

You can select all or part of the image in the Preview Work 
Area for the final scan. When you select only part of the 
image, you use the Scan Box and the ruler to specify the 
area you want to scan. You can also use the Scan Box to 
adjust the size of the image before you scan into the Final 
Work Area. 

Overlay Modes 

OFIS Imager provides two Overlay modes, Replace and 
Combine, for scanning images into the Final Work Area. 
An image scanned in Replace mode (the default setting), 
overwrites any image(s) already in the Final Work Area, 
whereas an image scanned in Combine mode merges with 
any image(s) in the Final Work Area. You use Combine to 
build composite images. 

Size Modes 

OFIS Imager has two Scan Size modes, Maintain Size and 
Change Size. Maintain Size is the default setting; it means 
that when you change the size of the Scan Box in one work 
area, you change the size of the Scan Box in the other work 
area in the same way. In effect, using Maintain Size 
causes the preview image and the final image to be the 
same size. If you switch to Change Size, you can scan a 
final image that is smaller or larger than the preview 
image. 
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Performing the Final Scan 

To perform the final scan, use the following procedure: 

1 From the Output Device pop-up menu, choose a printer. 
2 With the Scan Size mode set at the default (Maintain 

Size), draw a Scan Box around the area of the image in 
the Preview Work Area that you want to scan into the 
Final Work Area. Note that a similar box is formed in 
the Final Work Area. 
Remember that the Scan Box is an arrangement of 
rectangular handles that you can use to move and 
change the shape of the box. Refer to subsection Using 
the Mouse in section 2 for tips on how to draw a Scan 
Box. 

3 When you finish drawing and reshaping the Scan Box, 
move the cursor to the picture tab above the Final Work 
Area and click Mark. 

Note: If you do not perform this step, OFIS lmager replaces 
the image in the Preview Work Area with the image in the 
scanner. 

4 If you want to change the size of the image as it is 
scanned from the Preview Work Area to the Final Work 
Area, use the following procedure: 
1 Select Change Size. 
2 Draw the Scan Box in the Final Work Area to 

represent the size you want the final image to be. 
The minimum and maximum sizes of an image are 
limited to the sizes allowed by your scanner. You can 
not draw the Scan Box any smaller or larger than 
permitted by the scanner. For more information, 
refer to subsection Scan in section 4 of this document 
or refer to your scanner documentation. 

5 From the Scan menu, choose an Overlay mode by 
selecting the box next to Replace or Combine. (To 
overwrite the contents in the Final Work Area with a 
new image, select Replace. To merge the image(s) in the 
Final Work Area with another image, select Combine.) 
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6 Selectthe Scan icon. 
While scanning is in progress, the message Scanning ... 
displays below the scan areas. 

Note: OFIS lmager may scale the image at this time and 
display the message Scaling ... Scaling occurs when your Final 
Work Area resolution differs from the resolution of your 
image. Scaling may result in distortion of your image. 

Since the final scan captures an image that is of higher 
resolution (that is, finer detail) than the one in the Preview 
Work Area, the final scan takes longer than the preview 
scan. 

Scanning Directly into the Final Work Area 

OFIS Imager is preset at the start of each session to scan 
from the scanner (or from a file) directly to the Final Work 
Area. In this way, you utilize the default settings and 
bypass the Preview Work Area. 

To scan an image directly into the Final Work Area, use 
the following procedure at the start of your session: 

1 Place the page into the scanner. 
2 Select the Scan icon. 

An image of the page in the scanner appears in the 
Final Work Area. 

Once an image is scanned into the Final Work Area, you 
can edit it with tools from the Edit menu. The following 
material describes each of these tools and how to use them. 

Changing the View of an Image 

There are two ways to alter the view of an image on the 
screen to facilitate editing. You can use Single Layout to 
display more space to work with; using this option causes 
the active work area to take over the entire OFIS Imager 
screen. You can use the Zoom In tool to zoom in on all or 
part of an image so that its details become larger and 
clearer. 
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Using Single and Dual layout 

At the start of an OFIS Imager session, the screen defaults 
to Dual Layout; that is, it displays the two work areas side 
by side. You can change this setting to Single Layout using 
the Layout icon displayed between the two picture tabs at 
the top of the screen. 

To change the layout of the screen from Dual Layout to 
Single Layout, use the following procedure: 

1 Select the Layout icon. 
The active work area increases to fill the screen. If you 
look closely, you can see that the ruler displays show 
finer detail. Although only one of the work areas is now 
displayed, both picture tabs still appear so that you can 
switch back and forth between the two work areas. 

2 To view the other work area, select its picture tab. 
3 To return to Dual Layout, select the Layout icon again. 

Using Zoom In 
To magnify an image so that you can view it or a part of it 
in greater detail, you use the Zoom In tool. You can use 
Zoom In in either work area, but this tool is more useful in 
the Final Work Area where it is applied to the 
high-resolution image. If you use Zoom In in the Preview 
Work Area, the zoomed image does not appear as clearly as 
you might expect. 

To magnify a portion of an image using Zoom In, use 
the following procedure: 

1 From the Function menu, select Views. 
2 From the Views pop-up 1nenu, seiect Zoom In. 

The Zoom In cursor displays on the screen. You use it 
to set the size and position of the Zoom Box, which 
instructs OFIS lmager on how much of the image you 
want to magnify. The default size of the Zoom Box 
gives a 1:1 enlargement of the image. Using this default 
setting is the fastest way to magnify an image. The 
default Zoom Box also shows how the image will print. 

3 To move the Zoom Box, move the mouse. 
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4 To resize the Zoom Box: 
o Press the Bound button and drag the mouse. 
D Release Bound. 
When you change the size of the Zoom Box, 
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OFIS Imager scales the image up or down, slowing the 
magnification process. Note that a smaller Zoom Box 
magnifies an image (or part of an image) more than a 
larger Zoom Box. 

5 When the Zoom Box properly surrounds the portion of 
the image you want to magnify, click Mark. 
To edit the resulting magnified image, refer to Editing 
Images later in this section. To print the zoomed image, 
refer to Printing Images later in this section. 

6 To see another part of the image and magnify it, return 
to step 1. 

7 To stop working in the Zoom In mode, select Full Page 
from the Views pop-up menu. 

Note: Dual layout and Single layout have separate Zoom In 
modes. Zooming in on an image in one work area does not 
automatically cause you to zoom in on the same image in the 
other work area. You need to magnify within each work area 
separately. 

Editing Images 

Editing images introduces the concept of a third box: the 
Edit Box. (So far you have also learned about the Scan Box 
and the Zoom Box.) As you might expect, you use the Edit 
Box to define a part of an image you want to edit. The Edit 
Box appears only when the Edit menu is displayed from 
the Final Work Area. 

OFIS Imager's Edit menu presents five editing tools you 
can use to alter your images in the Final Work Area. The 
editing tools are: 
D Fill 
D Erase 
D Reverse 
o Mirror Left-Right 
D Mirror Up-Down 

These edit tools are shown in figure 3-8. 
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Figure 3-8 OFIS lmager Edit Tools 
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These tools can be used alone or in conjunction with each 
other; in other words, you can apply one or more at a time 
in the same editing procedure. 

OFIS Imager also provides an editing mode, which allows 
you to edit material outside the Edit Box (the Exterior) or 
inside the Edit Box (the Interior). Editing tools work only 
in the Final Work Area. 

The Undo command (F2), when issued immediately after 
Fill, Erase, Reverse, or Mirror, reverses the edit command 
and restores the image to its condition before you used the 
edit tool. 

Interior and Exterior Modes 

Before the edit tools are further explained, you should 
becomes more familiar with the two edit modes, Interior 
and Exterior. When you start a session in OFIS Imager, 
the results of using an edit tool apply only to material 
inside the Edit Box you draw; in other words, OFIS Imager 
defaults to Interior mode the first time you bring up the 
Edit menu for an editing session. For all edit tools except 
the two mirroring tools, you can change the edit mode to 
Exterior so that your edit applies to the area outside the 
edit box instead of the area inside the box. 

To choose Interior or Exterior mode: 

1 If you have not already done so, click More from the 
Scan menu to display the Edit menu. 

2 Select either the Interior or the Exterior icon (shown 
in figure 3-9). 
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Figure 3-9 Interior and Exterior Icons 

a 
Filling and Erasing 
The filling and erasing tools allow you to convert the 
defined edit area to all-black (Fill) or all-white (Erase). If 
your session is in Interior edit mode, Fill and Erase 
convert the image dots inside the Edit Box, including the 
area under the Edit Box, to black or white, respectively. If 
the editing session is in Exterior mode, Fill and Erase 
convert all dots outside the Edit Box, including the area 
under the Edit Box, to black or white, respectively. 

Note: Using the Fill and Erase edit tools convert the image 
dots to all-black and all-green, respectively, on a monochrome 
monitor. 

The Fill and Erase edit tools are not only useful for 
modifying images, they also serve as cleanup tools. You can 
use these tools to convert a portion of an image to 
all-black or all-white before laying part of another image 
over it. You can also use these tools to remove unwanted 
portions of the images. 

To use Fill and Erase, use the following procedure: 

1 Make certain the Final Work Area is active (refer to 
Picture Tabs earlier in this section for more 
information). 

2 If necessary, select More to display the Edit menu. 
3 Choose either the Interior or the Exterior edit mode. 
4 Choose a tool: 

o To choose Fill, select the Paint Roller icon. 
o To choose Erase, select the Chalk Eraser icon. 
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5 Position the Edit Box to define the area you want to 
edit with your tool. 
o To move the Edit Box, move the mouse. 
o To resize the Edit Box, press Bound and drag the 

mouse. 
6 Click Mark. 

The area defined by the Edit Box and the edit mode is 
converted to all-black or all-white, depending on the 
tool you chose. 

7 Repeat steps 3 to 6 to Fill and Erase other parts of the 
image. 

Reversing 

Once you scan an image into the Final Work Area, you can 
reverse it, meaning that its black dots are converted to 
white (green on a monochrome monitor) and vice versa. 
(An analogy to this is when you look at the negative of an 
actual photograph, and its dark areas appear white and 
vice versa.) 

To reverse an image, use the following procedure: 

1 Make certain that the Final Work Area is active (refer 
to Picture Tabs earlier in this section for more 
information). 

2 If necessary, select More from the Scan menu to display 
the Edit menu. 

3 Choose either the Interior or the Exterior edit modes. 
4 Select the Reverse edit tool. 
5 Position the Edit Box to define the area you want to 

reverse. 
o To move the Edit Box, move the mouse. 
o To resize the Edit Box, press Bound and drag the 

mouse. 
6 Click Mark. 

The image is reversed. 
7 Repeat the steps above to reverse more of the original 

image. 
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You can return the image to its original state, provided you 
have not resized or repositioned it. To do this, simply select 
Reverse again. Alternatively, you can select Undo from 
the Function menu, provided you have not used another 
command in the meantime. 

Mirroring 

The Mirror Left-Right and Mirror Up-Down edit tools 
can only apply to the image inside your Edit Box. 

To mirror an image, use the following procedure: 

1 Make certain the Final Work Area is active (refer to 
Picture Tabs earlier in this section for more 
information). 

2 If necessary, select More from the Scan menu to display 
the Edit menu. 

3 Select the Interior edit mode (mirroring is unavailable 
in the Exterior mode). 

4 Select either the Mirror Left-Right or the Mirror 
Up-Down edit tool. 

5 Position the Edit Box to define the area you want to 
mirror. 
o To move the Edit Box, move the mouse. 
o To resize the Edit Box, press Bound and drag the 

mouse. 
6 Click Mark. 

The portion of the image you are editing is mirrored. 
7 Repeat the steps above to mirror another part of the 

image. 

Note: If you attempt to mirror the image outside of the Edit 
Box (Exterior mode), an error message Cannot do this outside 
the defined box ... displays. 
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Locking and Unlocking the Edit Box 

When you perform multiple edits on the same part of an 
image, you may find it helpful to lock the Edit Box into 
place. Locking the Edit Box allows you to use an editing 
tool on a select portion of an image (that part of the image 
that has been locked by the Edit Box). Unlocking the Edit 
Box deselects the portion of the image and the editing tools 
can be used on the entire page. You use the Quick Menu to 
lock and unlock the Edit Box. 

To display the Quick menu from the Edit menu, you simply 
click the middle mouse button or press CODE-M. The Lock 
and Unlock icons appear (refer to figure 3-10). 

Figure 3-10 Lock and Unlock Icons 

To familiarize yourself with the Lock and Unlock 
options, use the following procedure: 

1 Make certain the Final Work Area is active. 

2 If necessary, select More from the Scan menu to display 
the Edit menu. 

3 Choose the Interior edit mode. 

4 Use the Edit Box to define the area you want to edit. 
5 Click the middle mouse button (or press CODE-M) and 

select the Lock icon. 
6 Select an edit tool, such as Mirror Left-Right. 
7 Select a second editing tool, such as Reverse. 
8 Click the middle mouse button (or press CODE-M) and 

select the Unlock icon. 

You can now position the Edit Box over another part of the 
image and perform additional edit operations. 
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Filing Images 

Filing images allows you to save the contents of an image 
you edit from session to session, and it also allows you to 
store and retrieve images you may use several times. You 
can even retrieve images created by others because such 
images can be stored on a master workstation, transferred 
on a floppy disk, or mailed electronically. 

Images can be stored in a wide range of volumes and 
directories. OFIS Imager provides a Set Path command 
that you can use to access all of these directories. The 
same command allows you to specify to which path you 
want to store an image. 

Saving Images 

After you capture an image into the Final Work Area and 
are satisfied with the result, it is a good idea to save the 
image before you do anything else with it. Saving creates a 
permanent record of the image on the disk. 

To save an image, use the following procedure: 

1 From the Function menu, select F4 (Files). 
The Files pop-up menu appears on the screen. 

2 Select Save Image. 
A text entry field appears with an accompanying 
prompt. 

3 Type the name you want to assign to the image. Use the 
BACKSPACE and DELETE keys on the keyboard to 
correct typing mistakes. 
You can save a copy of the image in a different volume 
or directory from the one you are currently pathed to 
by typing the volume and directory names. For more 
information on pathing in general, refer to Changing the 
Path later in this section. 
o To erase the contents of the text entry line, press 

CODE-Delete. 
o To move the cursor to an end of the line, press 

CODE-Right Arrow or CODE-Left Arrow. 
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4 Press RETURN or select Go. 
If you typed a filename that already exists, the message 
Select Go to overwrite the existing file, else Cancel 
displays. 
If you press GO or select Go, the new image overwrites 
that contained in the file. 

Saving images is important when you are developing a 
composite image and want to save each version or building 
block as you progress. 

After an image has been saved, its name displays in the 
picture tab of the work area it occupies. This title informs 
you of the exact image you are working on. 

Retrieving Saved Images 

The Files pop-up menu contains a Get Image command 
that you use to retrieve saved images. 

To retrieve an image you saved, use the following 
procedure: 

1 Choose the desired work area by selecting the 
appropriate picture tab. 

2 From the Function menu, select F4 (Files). 
3 From the Files pop-up menu, select Get Image. 

The Get Image text entry field appears along the 
bottom of the screen. 

4 Type the name of the image you want to retrieve in the 
field. Include the volume and directory names if they 
differ from the default path displayed in the top right 
area of the screen. 

5 Press RETURN or select Go. 

The image is displayed in the work area you chose in 
step 1. If the image is not displayed, and you are certain it 
exists, try specifying a different directory or volume. For 
details on related pathing procedures, refer to Changing 
the Path in this section. 
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Changing the Path 

In OFIS Imager, a path is the specific volume and directory 
(disk location) of an image. Each disk, whether a hard disk 
or floppy disk, is known as a volume. Each volume is 
divided into directories, which are themselves collections 
of files. The default path is the volume and directory 
where you originally installed OFIS Imager and where you 
do most of your work If you want to work in another 
volume or directory, you use the Set Path command to 
specify a different path. 

Note: This path will remain when you exit from the 
OFIS lmager session. 

To change the path where image files may be stored, 
use the following procedure: 

1 From the Function menu, select F4 (Files). 

2 From the Files pop-up menu, select Set Path. 

The Set Path menu displays along the right side of the 
screen (refer to figure 3-11). 

3 Change the volume and directory names using the 
following steps: 

1 Move the cursor to the name you want to change and 
click Mark. 

2 To delete the current volume or directory names, use 
the BACKSPACE key on the keyboard. You can also 
press CODE-DELETE to delete the entire volume or 
directory names. 

3 Type the new volume name, and press RETURN or 
select Go. 

4 Type the new directory name, and press RETURN or 
select Go. 

The new volume or directory name displays in italics. 
4 Select Update at the bottom of the Set Path menu. 

The italics are removed to indicate that the new path 
has been set. 

It is helpful to keep track of where you create and store 
your images. If you change your preset volume or directory 
name, write down the full names of any images you then 
store. 
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Figure 3-11 The Set Path Menu 
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The printer you select at the start of an OFIS Imager 
session determines the resolution at which OFIS Imager 
scans and prints images. Scaling occurs if the resolution of 
the printer differs from the resolution of the output device. 

When printed, images are positioned on the page exactly as 
indicated by the rulers in the work area. Note that images 
can only be printed from the Final Work Area. You should 
allow approximately 1/2 inch of blank space along each 
edge of the page, since some printers cannot print to the 
very edges of a page, and printed images will be cut off at 
these boundaries. 
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To print an image, use the following procedure: 

1 From the Function menu, select F5 (Print). 
The Print menu displays (refer to figure 3-12). 

3-29 

2 To print more than one copy, change the default 
number 1 using the Up Arrow icon next to Number of 
Copies until the number you want appears. (You can 
decrease this number by selecting the Down Arrow 
icon.) You can also enter the value using the keyboard. 

3 To alter the view of the screen that is printed, select 
the appropriate box under Print View. The boxes are: 
o Entire Image prints the entire image currently in 

the Final Work Area, even if a zoomed view is on 
display. 

o Current View prints the zoomed view displayed in 
the Final Work Area and fills the entire printed 
page. In other words, this function prints exactly 
what is on display. 

o Current/ Actual prints the current view in its actual 
size and position. In other words, a zoomed image 
will not print in the zoomed size, as it will in 
Current View. 

4 Select Go. 
The message Printing ... displays along the bottom of 
the screen as the image is printed. 
To stop printing, you select Cancel. 
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Figure 3-12 The Print Menu 
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Finishing an OFIS lmager Session 

You use the FINISH key on your keyboard to end an 
OFIS Imager session. The steps for ending your session 
differ depending on where you started. The following 
procedures explain how to finish an OFIS lmager session if 
you started from OFIS Designer and want to transfer an 
image there, or if you started from the Executive or 
Context Manager. 

Returning to OFIS Designer 

To return to OFIS Designer from an OFIS Imager 
session, use the following procedure: 

1 From the keyboard, press FINISH. 
2 Use the handles that surround the image in the Final 

Work Area to specify which portion of the image you 
want to transfer to OFIS Designer. 
o To move the box, select and drag the center handle. 
o To resize the box, select and drag various handles 

surrounding the image. 
The message Press Go to transfer the object, Finish 
to transfer nothing displays at the bottom of the 
screen. 

3 At this point, you have three alternatives: 
o To transfer the image to OFIS Designer, press GO. 

The message Transferring Object ... displays. 
o To transfer nothing back to OFIS Designer, press 

FINISH. 
o To continue in OFIS Imager, press CANCEL. 

If you choose this option, you can save your image 
and continue working in OFIS Imager. 

4 To properly place an image in your OFIS Designer 
document, refer to the appropriate sections regarding 
treatment of the OFIS Imager cooperating program in 
the BTOS OFIS Designer Operations Guide, Volume 3: 
Advanced Operations. 
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Returning to the Executive or Context Manager 

To return to the Executive or Context Manager from an 
OFIS Imager session, use the following procedure: 

1 From the keyboard, press FINISH. 
The message Press Go to confirm Finish displays. 

2 Press GO. 

If you altered the image currently displayed in either of 
the two work areas since the last time you used the Save 
Image command, OFIS Imager informs you that any work 
completed since will be lost and prompts you to confirm or 
cancel the Finish command. If no work has been done since 
your last save, the session finishes without any further 
warning, and you return to either the Executive or Context 
Manager. 

Note: When you start an OFIS lmager session, OFIS lmager 
creates a temporary file in the <$*> directory which it uses to 
display your image. These temporary files are automatically 
deleted if you finish the session using the previously described 
methods. However, if your session unsuccessfully finishes you 
must delete these temporary files before starting your next 
OFIS lmager session. For more information refer to the 
subsection Finish in section 4. 
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Command and Function Reference 

This section provides an alphabetical listing of the 
commands and functions found on the various menus in 
OFIS Imager. Each command and function is described and 
the procedure for its use is briefly explained. 

For another explanation of each command and function, 
refer to section 3. The index located in the back of this 
guide is helpful for determining where to find the 
information you need in this section. 
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Bound 

Bound is a command you access by pressing the right 
button on the mouse. (If the mouse has been set up for 
left-handed use, however, you access Bound by pressing 
the button on the left.) The command serves three 
purposes: 
o dismissing the Scan Box from either of the work areas 
o dismissing any pop-up menu 
o resizing the Zoom Box and the Edit Box 
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Brightness 

You use the Brightness function to lighten or darken an 
image as it is scanned. You may need to set the brightness 
level before you scan an image. The Brightness scale does 
not determine shading; instead, OFIS Imager varies the 
shading according to the option you choose in Photo Mode. 

The number of options on the Brightness scale depends on 
the type of scanner connected to your workstation. 

To change the Brightness scale, move the cursor to a 
setting and click Mark. 

In general, choose a darker setting (toward the left end of 
the scale) when the image you want to scan is light. Choose 
a lighter setting (toward the right end of the scale) when 
the image is dark. 

If you want to change the brightness level of an image you 
have already scanned, select the desired brightness level 
and rescan the image. 
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Cancel 

Cancel performs several functions. You can use it to: 
o cancel the printing of an image 
o dismiss a pop-up menu or function menu 
o clear an error message 
o cancel scanning 

You cannot use the Cancel function to interrupt edit 
operations such as mirroring or erasing; instead you use 
the Undo command to undo the effects of these operations. 
Further, you must use the Cancel key (F8) on the 
keyboard to cancel scanning and printing operations. 

There are two ways to access the Cancel command: 
o From the Function menu, select Cancel (F8). 
o Press the CANCEL key on the keyboard. 
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Change Size 

Change Size allows you to size each Scan Box in the two 
work areas independently of the other. When you draw 
Scan Boxes for the first time, they are the same size in 
both work areas. You use Change Size to size the boxes 
independently. Also, you use Change Size to size an image 
differently in each work area. 

For example, you may want to choose Change Size to 
create a composite image in the Final Work Area. You use 
this tool to specify how, where, and what size the 
components of that final image should appear. Since you 
cannot change the size of images once they have been 
scanned in, it is important to size them beforehand. 
Change Size allows you to accomplish this. 

Note: You can not enlarge an image scanned with a Microtek 
MS-300A scanner with the Change Size tool. OFIS lmager 
indicates this by providing only five scan handles when you switch 
to the Change Size option. To increase the size of the image 
beyond the hardware limit, save the image in a file and scan it in 
to your work area with the desired size. 

To choose Change Size from the Scan menu, select the 
Change Size icon. 

A highlighted box is displayed beneath the icon. 

In this mode, the Bound button on the mouse dismisses 
both Scan Boxes, in single or dual layout. 
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Clear Work Area 

The Clear Work Area (F9) function removes an image 
from the entire active work area. You use this command 
when the image you scan is unsatisfactory or if you want 
to start over. Clear Work Area removes the image from 
the work area only; it does not affect the version of an 
image that you save on the disk. 

To clear a work area, use the following procedure: 

1 From the Function menu, select Clear (F9). 
2 From the resulting pop-up menu, select Yes. (To cancel 

the command, select No.) 
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Combine 

Combine, is one of the two Overlay modes, (Replace is the 
other). Combine allows you to merge images. When you 
scan an image into the Final Work Area, Combine mode 
causes the image in the scanner to merge with any image(s) 
in that work area. 

When you start an OFIS Imager session, the Overlay mode 
automatically defaults to Replace, the opposite mode of 
Combine. 

To change to Combine mode, select the box next to 
Combine. 
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Dual Layout 

Dual Layout is a function which allows you to view both 
the Preview Work Area and the Final Work Area at the 
same time, side-by-side. At the beginning of each 
OFIS Imager session, the screen is in Dual Layout. Each 
work area is the same size and has its own ruler display. 
You can enlarge either of the two work areas to occupy the 
entire work area portion of the screen; this function is 
called Single Layout. 

The Layout icon, located at the top of the screen between 
the picture tabs, displays the choice of layout that you 
currently do not have. That is, the Layout icon consists of 
one box when the screen is in Dual Layout, and two boxes 
when the screen is in Single Layout. 

When the screen is in Dual Layout, only one of the work 
areas displayed is active; its picture tab is highlighted. 

To change Layout mode, select the Layout icon at the top 
of the screen. 
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Erase 

The Erase command converts all the dots (bits) inside and 
outside the Edit Box to the background color of the screen. 

If the screen is in Interior edit mode, all dots inside the 
Edit Box convert to the background color, including the 
Edit Box and those under the Edit Box, upon executing the 
Erase command. If the screen is in Exterior edit mode, all 
dots outside the Edit Box, including those under the Edit 
Box, convert to the backgound color upon executing the 
command. 

Erase is the opposite of Fill, described later. 

To use Erase: 

1 Scan an image into the Final Work Area. 
If necessary, select More to display the edit tools and 
the Edit Box. 

2 Select Interior or Exterior edit mode. 
3 Select the Erase icon. 
4 Position and size the Edit Box to define the area of the 

image you want to erase. 
5 Click Mark. 

To undo the results of the Erase command, select 
Undo (F2). 
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Exterior 

Exterior instructs OFIS Imager to apply the effects of the 
Erase, Fill, and Reverse edit commands to material 
outside of the Edit Box. Exterior is the opposite of 
Interior, which applies edit tools to material inside the 
Edit Box. 

To choose Exterior edit mode: 

1 From the Edit menu, select Exterior. 
2 Select one of the edit tools that functions in Exterior 

mode: Erase, Fill, or Reverse. 
3 Click Mark. 

The area outside the Edit Box shows the results of the edit 
tool you applied. 
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Files 

Files (F4), found in the Function menu, displays a pop-up 
menu that contains three options you use to perform the 
following file operations: 
o Set Path 
o Get Image 
o Save Image 

To access the Files menu: 

1 From the Function menu, select Files (F4). 
2 From the Files pop-up menu, select a command listed 

above. 

Depending on the option you choose, one of several 
prompts is displayed. The prompts guide you through the 
steps needed to complete the command. 
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Fill 

The Fill edit command converts all the dots (bits) inside 
and outside the Edit Box to the foreground color of the 
screen. 

If the screen is in Interior edit mode, all dots inside the 
Edit Box, including those under the Edit Box, convert to 
the foreground color when you apply the Fill tool. If the 
screen is in Exterior edit mode, all the dots outside the 
Edit Box, including those under the Edit Box, convert to 
the foreground color when you use this tool. 

Fill is the opposite of Erase, described earlier. 

To use Fill: 

1 Scan an image into the Final Work Area. 
If necessary, select More to display the edit tools and 
the Edit Box. 

2 Select either Interior or Exterior edit mode. 
3 Select the Fill icon. 
4 Position and size the Edit Box to define the area of the 

image you want to Fill. 
5 Click Mark. 

To undo the result of the Fill command, select Undo (F2). 
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Final Work Area 

The Final Work Area is the right work area when the 
screen is in Dual Layout. This area contains the final image 
you are composing, and is the only work area where images 
can be modified or printed. 

To activate the Final Work Area, select the right picture 
tab. 

When the Final Work Area is active, the right picture tab 
is highlighted, and you perform operations in that area. 

5029895 



4-14 Command and Function Reference 

Finish 

You use the FINISH key, located on your keyboard, to 
finish an OFIS Imager session. The steps for ending an 
OFIS Imager session differ depending on where you started 
the session. 

To finish your OFIS Imager session, if you started from 
OFIS Designer: 

1 Press FINISH. 
2 Use the handles that surround the image in the Final 

Work Area to specify precisely which portion of the 
image you want to transfer to OFIS Designer. 
The message Press Go to transfer object, Finish to 
transfer nothing displays. 

3 At this point, you have three alternatives: 
o To transfer the image back to OFIS Designer, press 

GO. 
The message Transferring Object ... displays. 

o To transfer nothing back to OFIS Designer, press 
FINISH. 

o To cancel the command and continue in 
OFIS Imager, press CANCEL. 

4 To properly place the image in your OFIS Designer 
document, refer to the BTOS OFIS Designer Operations 
Guide, Volume 3: Advanced Operations. 

To finish your OFIS Imager session, if you did not start 
from OFIS Designer: 

1 Press FINISH. 
The message Select Go to confirm Finish, else Cancel 
displays. 

2 Press GO. 

If you altered the image currently displayed in either of 
the two work areas since your last save, OFIS Imager 
informs you that such work will be lost. Otherwise, the 
session automatically finishes and you return to either the 
Executive or Context Manager. 
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If your OFIS Imager session unsuccessfully finishes you 
must be aware that OFIS Imager creates temporary files in 
the <$*> directory of your workstation which it uses to 
display your image. These temporary files are 
automatically deleted if you finish the session using the 
previously described methods. If your session 
unsuccessfully finishes, you must delete these temporary 
files before starting your next OFIS Imager session. 

To manually delete OFIS Imager temporary files: 

1 At the Executive command line, enter Delete. 
2 Press RETURN. 

The Delete command form displays. 
3 Specify the OFIS lmager temporary files, <$*>*Vm* in 

the [File list] parameter. 
4 If you want to confirm each file that will be deleted, 

enter yin the [Confirm each?) parameter. The default 
is No. 

5 Press GO. 

Your OFIS Imager temporary files are deleted. 
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Full Page 

Full Page displays the entire image in the work area. 
When the screen is in Single Layout, the image fills the 
active work area. When the screen is in Dual Layout, Full 
Page displays the image on the left side of the screen. You 
can use Full Page after Zoom In the entire page. 

To display the entire page: 

1 From the Function menu, select Views (F6). 
2 From the Views pop-up menu, select Full Page. 
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Full View 

In Dual Layout, Full View and Full Page are the same. In 
Single Layout, Full View displays the top half of the 
page. 

To display the top part of the page (in Single Layout): 

1 From the Function menu, select Views (F6). 
2 From the Views pop-up menu, select Full View. 
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Get Image 

You use Get Image to retrieve an image you saved. Get 
Image displays the image in the active work area. 

You can select portions of a saved image by reading the 
image file into the Preview Work Area, then selecting 
portions of that image and using the Scan File icon to scan 
them into the Final Work Area. 

To retrieve an image: 

1 From the Function menu, select Files (F4). 
2 Select Get Image. 

The Path menu appears where the Scan or Edit menu 
normally is, and a text entry line displays at the bottom 
of your screen. 

3 Type the name of the image you want to retrieve in the 
text entry line. 

4 Select Go. 
The image appears in the active work area. 
The Scan or Edit menu redisplays. 

You can retrieve an image from a location other than the 
default path by including the volume and directory names 
as part of the filename. The image is retrieved from the 
specified path without altering the default path. You use 
the following parameters for entering a complete filename: 

{node}[volume]<directory>imagename 
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Go 
Go executes an operation. Selecting Go (FlO) from the 
Function menu on the OFIS Imager screen is the same as 
pressing the GO key on your keyboard. The Go command 
appears in certain pop-up menus as well. 

You select Go or press GO, as appropriate, to execute an 
operation. 
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Help 

The Help function briefly describes the purpose of an icon 
or function. 

To use Help: 

1 Select Help on the OFIS Imager screen, or press the 
HELP key on the keyboard. 
The cursor now displays as a question mark. 

2 Move the question mark cursor to an icon or function 
indicator and click Mark. 
A one-line description of the icon or function appears 
at the bottom of the work areas. 

3 To stop using Help, select Help again or press 
CANCEL. 

Note: Help is not available for pop-up menus. 
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Interior 

Interior instructs OFIS Imager to apply the effects of an 
editing tool to material inside the Edit Box. Interior is the 
opposite of Exterior, which applies the effects of an 
editing tool to material outside the Edit Box. 

To choose Interior edit mode: 

1 From the Edit menu, select Interior. 
2 Choose any edit tool. 
3 Click Mark. 

The area inside the Edit Box shows the results of the edit 
command you chose. 
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Layout Icon 
The Layout icon, which appears at the top of the work 
areas between the picture tabs, indicates the layout of the 
screen (Dual Layout or Single Layout). Dual Layout 
means that the two work areas display on the screen 
simultaneously, side-by-side: the Preview Work Area on 
the left and the Final Work Area on the right. Single 
Layout means that one of the two work areas is enlarged 
to fill the screen (but both picture tabs still appear so that 
you can access the invisible work area). 

The Layout icon's appearance changes depending on the 
layout itself. In Single Layout, the icon appears as a 
double box to indicate that selecting it results in Dual 
Layout. In Dual Layout, the icon appears as a single box 
to indicate that selecting it results in Single Layout. 

To alternate between Single Layout and Dual Layout, 
select the Layout icon. 
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Line Art 

Line Art, one of the two icons you use to inform 
OFIS Imager of the type of image in the scanner, indicates 
that only lines are picked up from the picture. Since Line 
Art mode does not pick up any kind of shading in an 
image, you use it for line drawings that are primarily black 
or white (no colors). (You should use the Photograph mode 
for images you want to scan that contain shading.) 

Each OFIS Imager session defaults to Line Art mode until 
you change it. You may choose between the Line Art mode 
and Photograph mode before you scan an image. 

To choose Line Art: 

1 If necessary, select More on the Edit menu to return to 
the Scan menu. 

2 Move the mouse to the Line Art icon and click Mark. 

Note: When combining line art and photographs in the Final 
Work Area, some scaled views may result in a dithered 
appearance; this includes various levels of zoom as well as the 
full page view. If you display at Max Zoom the bits of the image 
appear as they will when printed, and in the case of line art, the 
appearance becomes sharper. 
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Lock 

Lock, as opposed to Unlock, is one of the two options on 
the Quick menu, available only when the Edit menu is 
displayed. Lock is valuable when you are performing more 
than one edit to a defined area; this command locks the 
Edit Box in place so that each tool in the series you choose 
applies itself precisely to the same area. 

To lock the Edit Box: 

1 Position and size the Edit Box to define the portion of 
the image you want to edit. 

2 Click the middle mouse button, or press CODE-M. 
The Quick Menu appears; it contains two icons: Lock 
and Unlock. 

Note: This maintains the position of the Edit Box until you 
click Unlock or Bound or you press CANCEL. 

3 Move the cursor to Lock and click Mark. 
4 Select the desired edit tool(s). 
5 To Unlock the Edit Box, click the middle mouse button, 

or press CODE-M, and select Unlock. 

Note: You automatically unlock the Edit Box when you switch 
from the Edit menu to the Scan menu by selecting the More 
icon. 
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Mail Notification 

When you receive electronic mail while in OFIS Imager, the 
Mail icon, a small envelope, appears in the upper left 
corner of the screen. When the mail is urgent, the icon 
displays in reverse video on a monchrome monitor and red 
on a color monitor. 
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Maintain Size 

Maintain Size allows you to size the Scan Boxes in both 
work areas identically. Each OFIS Imager session defaults 
to Maintain Size mode until you change it. 

To choose Maintain Size, select the Maintain Size icon 
from the Scan menu. 

A highlighted box is displayed beneath the icon. 

In this mode, the Bound button on the mouse dismisses 
both Scan Boxes. 

Once drawn, you can change the relative positions of the 
Scan Boxes in the two work areas. To move one box 
independently of the other, you drag its middle handle. 

Note: Once you resize one or both of the Scan Boxes, Maintain 
Size can not be used to maintain the relative sizes of the Scan 
Boxes. You must redraw the Scan Boxes after switching back to 
Maintain Size to size the Scan Boxes together. 
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Mark 

The Mark button corresponds to the left button on the 
mouse (or the right button if the mouse is set up for 
left-handed use). You use this button to: 
o select functions, commands, and edit icons from the 

various menus 
o draw the Scan Box 
o resize and reposition the Scan Box 

4-27 

o specify what part of an image you want to scan or edit 

You use the Set Up menu to specify right-handed or 
left-handed use of the mouse. You can also specify a 
default for left-handed or right-handed use of the mouse; 
for details, refer to appendix B. 
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Mirror Left-Right 

The Mirror Left-Right edit tool mirrors the contents of 
the Edit Box from left to right. Both mirroring commands 
(the other being Mirror Up-Down) work only in Interior 
edit mode. 

To mirror an image from left to right: 

1 If necessary, select More from the Scan menu to display 
the Edit menu. 

2 Choose Interior edit mode. 
3 Select the Mirror Left-Right edit tool. 
4 Position the Edit Box to define the area of the image 

you want mirrored. 
5 Click Mark. 

The message Mirroring ... displays at the bottom of the 
screen. 

The Mirror Left-Right edit tool is one of several 
OFIS Imager commands that you can undo. To undo the 
result of the command, you select Undo (F2). 
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Mirror Up-Down 

The Mirror Up-Down edit tool mirrors the contents of the 
Edit Box from top to bottom. Both mirroring commands 
(the other being Mirror Left-Right) work only in Interior 
edit mode. 

To mirror an image from top to bottom: 

1 If necessary, select More from the Scan menu to display 
the Edit menu. 

2 Choose Interior edit mode. 
3 Select the Mirror Up-Down edit tool. 
4 Position the Edit Box to define the area of the image 

you want mirrored. 
5 Click Mark. 

The message Mirroring ... displays at the bottom of the 
screen. 

The Mirror Up-Down edit tool is one of several 
OFIS Imager commands that you can undo. To undo the 
result of the command, you select Undo (F2). 
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More 

More, located on both the Scan menu and the Edit menu, 
allows you to switch back and forth between the two 
menus. Selecting More from either menu allows you to see 
the alternative set of commands and icons. 

Note: If you draw a Scan Box and then use More to switch to 
the Eqit menu, the Scan Box is preserved and remains 
unchanged so that you can switch back to the Scan menu to 
resume a scanning task. However, if you draw an Edit Box and 
then use More to switch to the Scan menu, the Edit Box is 
destroyed (even if locked). You need to resize the Edit Box 
everytime you switch to the Edit menu from the Scan menu. 



Command and Function Reference 4-31 

Mouse Hand 

Mouse Hand, an option on the Set Up menu, allows you to 
set up the mouse for either right-handed or left-handed 
use. At the beginning of each OFIS Imager session, the 
Mark function defaults to the left button and Bound 
defaults to the right button (the middle button is always 
the Quick Menu function on your three-button mouse). 
These defaults are intended for right-handed use of the 
mouse. You can reverse the position of Mark to the right 
button and Bound to the left button by selecting Left 
Handed from the Set Up menu. You can also specify a 
mouse hand default by editing an entry in the user 
configuration file; for more details on this procedure, refer 
to appendix B. 

To change Mouse Hand: 

1 From the Function menu, select Set Up (F3). 
2 From the Set Up pop-up menu, select Left Handed or 

Right Handed, according to your preference. 
3 Select Go. 
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Output Device 

Before you scan an image, you select an output device or 
printer, because the printer you select determines the final 
resolution of the image you scan. However, you can set 
your own resolution. For information on setting 
resolutions, refer to RESOLUTION later in this section. 

To select a printer: 

1 From the Scan menu, select Output Device. 
The Output Device pop-up menu displays. 

2 Move the cursor next to the desired printer name and 
click Mark. 

The name of the GPS-installed printers appears under 
Output Device in the Scan menu, and the pop-up menu 
disappears. 

If you do not select a printer, and one is not specified in 
the User Configuration File (refer to appendix B), the first 
printer name in the list becomes the default printer. This 
printer then determines the resolution at which images are 
scanned. 

You can output to a different printer than the one specified 
under Output Device by using the Print pop-up menu, 
accessed from the Print function key (F5). If the printer 
resolution differs from the resolution of the image, the 
image will be scaled. Scaling may cause distortion of your 
image. 

If you select a different printer, after you scan the image 
you want printed, and if that second printer is configured 
for a different resolution than the first, OFIS Imager 
prompts you to clear the image or to reselect your printer. 
The software does this because the first printer prompted 
the scanner to scan the image at a certain resolution, and 
the second printer is configured for a different resolution. 
OFIS Imager assumes that you want to clear the work area 
and scan the image a second time, under the resolution of 
the second printer. Therefore, you should decide exactly 
which printer you want as your output device before you 
scan an image. 
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Output Paper 

Output Paper, an option in the Set Up menu, informs 
OFIS Imager of the size of the page in the printer. This 
setting defaults to Letter unless an entry is made in the 
user configuration file to overwrite this value. (Refer to 
appendix B for more information.) This command does not, 
however, specify the size of the page in the scanner; Scan 
Size does this. 

To change Output Paper: 

1 From the Scan menu, select Set Up (F3). 
The Set Up menu is displayed. It contains the following 
four options for paper size: 

Letter 
Legal 
A4 
Custom 

for pages 8.5 inches by 11.0 inches 
for pages 8.5 inches by 14.0 inches 
for pages 8.3 inches by 11.7 inches 
for pages whose sizes differ from the other 
three 

2 To choose a paper size, select the box next to the size 
you want. 

3 To specify a custom paper size: 
o Select one of the arrows next to Custom Width until 

the width of the page in the printer is displayed. 
o Select one of the arrows next to Custom Height 

until the height of the page in the printer is 
displayed. 

Alternatively, select Custom Width (or Custom 
Height) and type the width (or height) of the page in 
the printer. 

4 Select Go at the bottom of the menu. 

Note: If the paper size default setting is set in the user 
configuration file to A4, the ruler markings are drawn in 
centimeters. 
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Overlay 

Overlay refers to the two modes, Combine and Replace, 
that you can work with when scanning images. Combine 
Overlay mode instructs OFIS Imager to merge the image in 
the scanner with that in the Final Work Area. In this way, 
you can use Combine to create composite images. Replace 
Overlay mode instructs OFIS Imager to overwrite the 
image in the Final Work Area with that in the scanner. 
OFIS Imager always defaults to Replace mode at the 
beginning of each session. 

To change the setting for Overlay mode select the box next 
to either Combine or Replace on the Scan menu, 
depending on your choice of modes. 

The box is highlighted to indicate the active Overlay mode. 
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Photo Mode 

The options under Photo Mode apply only when you select 
the Photograph icon. The Photo Mode options simulate 
different types of shading, depending on the image you 
scan. To see the difference between the various Photo 
Mode settings, you should scan several versions of the 
same image, adjusting the Photo Mode setting each time: 
then compare the results. You will discover your own 
preferences based on the scanner you use and the types of 
images you scan. 

The options that appear on the Photo Mode pop-up menu 
depend on the scanner connected to your workstation. 
Table 4-1 lists the Photo Mode settings for the Microtek 
MS-300A and the HP Scanjet scanner. The names 
Photocopy, Laser, and Display are recommendations 
based on how you may want to use the image you scan; for 
example, you should use one of the Photocopy settings if 
you plan to photocopy the printed image, and Laser if you 
want to get the best possible image from the laser printer. 
The Photocopy setting works best if you plan to print the 
image on a dot matrix printer. You are not, however, 
limited in your choices; you can, for example, print an 
image scanned in under Display-G. 

The letters following the setting names describe the 
patterns of dots present in the shading: C means Coarse, V 
means Vertical, H means Horizontal, G means Gray, and F 
means Fine. The column on the right refers to the size of 
the shading dots in the pattern. The smaller the number, 
the smaller the dot; therefore, the setting Laser-Fuses 
smaller dots than Laser-C. 
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Table 4-1 Photo Mode Settings 

Microtek MS-300A HP Scanjet 

Photocopy-C 8 Photocopy-C 8 
Photocopy-V 8 Laser-C 4 
Photocopy-H 8 Laser-V 4 
Photocopy-G 8 Display-G 4 
Photocopy-F 6 
Laser-C 5 
Laser-V 5 
Laser-H 4 
Laser-G 4 
Laser-F 4 
Display-F 4 
Display-G 4 

To choose a Photo Mode: 

1 From the Scan menu, select Photo Mode. 
2 From the Photo Mode pop-up menu, select your choice. 

Your choice appears beneath Photo Mode in the Scan 
menu, and the pop-up menu disappears. 
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Photograph 

You choose the Photograph icon, as opposed to the Line 
Art icon, to scan images that contain continuous tones. 
Such images include photographs, drawings, and other 
graphics that contain shading. After selecting Photograph, 
you can refine the halftones that OFIS lmager uses to 
simulate various degrees of shading by choosing one of the 
options displayed when you select Photo Mode. 

Note: When combining line art and photographs in the Final 
Work Area, some scaled views may result in a dithered 
appearance; this includes various levels of zoom as well as the 
full page view. If you display at Max Zoom the bits of the image 
appear as they will when printed, and in the case of line art, the 
appearance becomes sharper. 
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Picture Tab 

Each of the two work areas has its own Picture Tab, 
which serves two purposes. A Picture Tab displays the 
name of the image file contained in the work area beneath 
it. Also, you can activate a work area by selecting its 
picture tab; the active work area is then denoted by its 
highlighted picture tab. In general, commands and 
functions apply only to the active work area. 
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Preview Work Area 

Of the two work areas, the Preview Work Area is the left 
work area. It is used for viewing images from the scanner 
or images previously filed. This left area displays a 
low-resolution version of the scanned image; it is useful 
for specifying how much of the image you want to scan 
into the Final Work Area. You cannot edit an image in the 
Preview Work Area. 

When the Preview Work Area is active, the bar above it is 
highlighted, and all operations you perform affect the 
image in that area. 
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Print 

You use the Print (F5) function to print images to a 
printer. All GPS-supported graphics printers will support 
OFIS Imager. For information on output devices that 
support OFIS Imager, refer to your output device 
documentation. 

The output device you select at the start of an 
OFIS Imager session determines the resolution at which 
OFIS Imager scans images. Laser printers usually support 
higher resolution than dot matrix printers. You specify the 
size of the paper in the printer using the Set Up menu's 
entry for paper size. 

When printed, images are positioned on the page exactly as 
indicated by the rulers in the work area. You should allow 
approximately 1/2 inch of blank space along each edge of 
the page, since some printers cannot print to the very 
edges of a page, and printed images will be cut off at these 
boundaries. 

Note that images can only be printed from the Final Work 
Area. 

To print an image: 

1 From the Function menu, select Set Up (F3). 
2 Specify the size of the paper in the printer (refer to 

information on Paper Size). 
3 Select Go. 
4 Select Print (F5). 

The Print pop-up menu appears, containing preset 
values such that, if you press GO, one copy of the 
entire image prints on the default printer. You can 
change these settings as outiined in this subsection. 

5 Select Go. 

The message Printing ... displays along the bottom of 
the screen as the image prints. 

6 To cancel printing in progress, press the CANCEL key 
on the keyboard. 
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To change the settings in the Print menu: 

1 Select the Up Arrow or Down Arrow next to Number 
of Copies and increase or decrease the number of 
copies you want to print. Or, you can select Number of 
Copies and type a number to change this setting. 

2 Under Print View, select the box next to the view you 
· want to print (the default is Entire Image). 

o Entire Image prints the entire image appearing in 
the Final Work Area, in portrait mode. 

D Current View prints the zoomed view appearing in 
the Final Work Area; it fills the entire page. 

o Current/ Actual prints the current view in its actual 
size and position in the Final Work Area. For 
example, it does not print a zoomed image in the 
zoomed size. 
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Quick Menu 

The Quick Menu displays whenever you click the middle 
mouse button or press CODE-M while in edit mode. The 
Quick Menu consists of the Lock icon and the Unlock icon, 
which lock and unlock the Edit Box so that you can 
accurately perform multiple edits on the same part of an 
image. 

To use the Quick Menu: 

l From the Edit menu, choose Interior or Exterior edit 
mode. 

2 Size and position the Edit Box to define the area you 
want to edit. 

3 Click the middle mouse button or press CODE-M. 
4 Move the cursor to the Lock icon and click Mark. 
5 Select edit tools you want to apply to the area. 
6 When you finish with the edit tools, click the middle 

mouse button or press CODE-M again and choose 
Unlock. 

7 To dismiss the Quick Menu without choosing an icon, 
click Bound. 
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Replace 

Replace is one of the two Overlay modes (Combine is the 
other). Replace mode means that the image in the scanner 
replaces all or part of the image in the Final Work Area 
once it is scanned in. (Actually, the image in the scanner 
replaces only the material contained in the scan box within 
the Final Work Area. For this reason, not all material in 
the Final Work Area will necessarily be affected.) 

When you start an OFIS Imager session, the Overlay mode 
automatically defaults to Replace. 

To change Overlay mode, select the box next to Replace 
on the Scan menu. 
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Resolution 

Resolution refers to the detail at which an image is 
scanned or displayed. The higher the resolution, the more 
detailed the final image. Resolution is measured in dpi 
(dots-per-inch). The printer you select before scanning an 
image or displaying a file determines the resolution of that 
image. For example, if you choose a printer that has a 
resolution of 240 dpi by 180 dpi, the image scans into the 
Final Work Area with the same values. 

You can define your own custom resolution. The Set Up 
menu, accessed from the Function menu, contains two 
fields that you can use for this purpose, X Resolution and 
Y Resolution. Refer to SET UP MENU in this section for 
details. 

When the resolution of an image displayed in the Final 
Work Area differs from that specified either by the chosen 
output device or the values in the Set Up menu, 
OFIS Imager warns you that the resolution of the filed 
image will change. In this case, you should start over: clear 
the Final Work Area, then scan the file into that work area 
again. Using this process, OFIS Imager scales the filed 
image to match that of the chosen output device. 
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Reverse 

Reverse is one of the edit tools you use to modify an image 
in the Final Work Area. When you apply this tool, black 
dots are converted to white dots and white dots are 
converted to black dots. If you use the Reverse tool in 
Interior edit mode, the dots inside the Edit Box will 
reverse, including those under the Edit Box. If you use the 
tool in Exterior mode, the dots outside the Edit Box will 
reverse, excluding those under the Edit Box. 

Note: If you use the Reverse edit tool on a monochrome 
monitor, black dots are converted to green dots and green dots 
are converted to black dots. 

To use the Reverse tool: 

1 If necessary, select More from the Scan menu to display 
the Edit menu. 

2 Choose Interior or Exterior edit modes. 
3 Select the Reverse icon. 
4 Position the Edit Box to define the area of the image 

you want to reverse. 
5 Click Mark. 

The message Reversing ... displays at the bottom of the 
screen. 

Reverse is one of several OFIS Imager commands that you 
can undo. If you do not like the result of the Reverse 
command, you select Undo (F2). 

Note: Follow reversing procedure steps 1 through 5 to use the 
Reverse tool without locking the Edit Box. If you lock the Edit 
Box, perform step 4 before step 3. 
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Ruler Areas 

In each of the two work areas, there is a ruler display 
along the top and the left side. You use these ruler displays 
to measure and position the cursor, the Scan Box, the Zoom 
Box, and the Edit Box. To aid alignment, each ruler 
contains a marker that moves with the cursor to indicate 
the position of the cursor relative to the ruler. At the start 
of each OFIS Imager session, the area defined by the rulers 
is divided into inches; each inch is then divided into 
quarter-inches. 

Note: If the default output paper size is set to A4 in the user 
configuration file, the area defined by the rulers is divided into 
centimeters; each centimeter is then divided into 
quarter-centimeters. 

Using the Units entry in the Set Up menu, you can change 
the rulers' system of measurement into centimeters (the 
two options under Units are Inches and Centimeters). 
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Save Image 

Save Image saves an image from the Final Work Area to a 
file in the chosen path. As with most application software, 
it is a good practice to frequently save your work. The 
Save Image command places a permanent version of the 
image in a disk file. 

To save an image: 

1 From the Function menu, select Files (F4). 
2 From the Files pop-up menu, select Save Image. 
3 Type a name into the text entry field that appears. 

The image is saved in the current volume and directory, 
called a path. You can save an image in another volume 
or directory by typing in the appropriate volume and 
directory names immediately preceding the file name. 
Refer to Set Path for more information about pathing. 

4 Select Go or press GO, or press RETURN. 
OFIS lmager writes a permanent version of the image 
to disk, unless an image has already been saved with 
the same name. If the latter is true, the prompt Select 
Go to overwrite existing image, else Cancel displays. 

5 Select Go or Cancel as necessary. 

Note: When choosing a file name, although a file name can 
contain as many as 60 characters, it is advisable to keep the 
names short. Shorter names make it easier for you to copy, 
move, and recall images. 

When you save a file in OFIS Imager, a file suffix is added. 
All OFIS lmager files end with the following letters: 

.tif 

With this suffix you can use the Executive to list the 
names of OFIS Imager files. 

If images are contained in your .tif files, then you can scan 
these images into your OFIS Imager work area without a 
scanner. Simply follow Scan File procedure and specify 
the OFIS Imager file which contains the image you want to 
scan in. 

Note: Images are saved with the resolution at which they were 
scanned. 
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Scan 

The Scan function activates the scanner so that a version 
of the image in the scanner displays in one of the two work 
areas. When the Preview Work Area is active during an 
initial scan, a lower resolution version of the image is 
displayed in that work area. You then use the Scan Box to 
determine how much of the image you want scanned over 
to the Final Work Area for final processing. If, on the other 
hand, the Final Work Area is active, a high-resolution scan 
of the image goes into that area; the image is scaled for 
display on the screen and appears as it does when printed. 
The image in the Final Work Area comes from the scanner 
or from the portion of the image defined by the Scan Box 
in the Preview Work Area. 

You can not edit or print an image unless it is in the Final 
Work Area. 

To activate the scanner using the Scan icon, refer to 
information under Scanning an Image into the Preview 
Work Area and Scanning an Image into the Final Work 
Area in section 3. 

You can interrupt scanning in progress by pressing the 
CANCEL key on the keyboard; doing so, however, may 
result in a partial image scanned. 

For information on configuring your scanner, refer to 
appendix B. 
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Scan File 

Scan File opens an image file in the active Work Area (this 
procedure is equivalent to using Get Image in the Files 
menu). Scan File works in a similar way as Scan, except 
that Scan File does not look to the scanner for an image. 
Scan File recalls an image previously saved on hard or 
floppy disk. 

To read an image file into the Preview Work Area with 
the Scan File icon, use the following procedure: 

1 Select the picture tab above the Preview Work Area. 
2 From the Scan menu, select the Scan File icon. 
3 Type the name of the image file in the field provided, 

including the volume and directory names if the image 
is in a path different from the current one. 

4 Select Go or press GO, or press RETURN. 
The message Getting image ... displays. 
The image is displayed in the Preview Work Area. 

To read an image file from the Preview Work Area to 
the Final Work Area with the Scan File icon, use the 
following procedure: 

1 Draw a Scan Box over the part of the image in the 
Preview Work Area that you want to scan into the Final 
Work Area. 

2 Select the picture tab above the Final Work Area. 
3 Position the Scan Box in the location where you want 

the image to appear. 
If necessary, resize the Scan Box in the Final Work 
Area by selecting Change Size and modifying the box. 

4 Select the Scan File icon. 
The message Getting image ... displays. 
The image is displayed in the Final Work Area. 
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To read an image file directly into the Final Work Area 
with the Scan File icon, use the following procedure: 

1 Select the picture tab above the Final Work Area. 
2 From the Scan menu, select the Scan File icon. 
3 Type the name of the image file in the field provided; 

include the volume and directory names if the image is 
in a path different from the current one. 

4 Draw a Scan Box in the location where you want the 
image to appear. 
If necessary, you can resize the Scan Box by selecting 
Change Size and modifying the box. 

5 Select Go or press GO, or press RETURN. 
The message Getting Image .•. displays. 
The image displays in the Final Work Area. 

You can interrupt the Scan File operation by pressing the 
CANCEL key on the keyboard. 

Note: If your Final Work Area resolution is different from the 
resolution of the image, it will result in scaling of the image. 
While scaling is in process, the message Scaling .•• displays below 
the scan areas. Scaling may result in distortion of your image. 
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Scan Size 

You use Scan Size, contained in the Scan menu, to inform 
OFIS Imager of the size of the page in the scanner. You 
should use Scan Size before you scan the page. This 
function defaults to letter size (or to the paper size 
specified in the Output Paper entry in the user 
configuration file) if you do not set it each time you 
perform a scan. Scan Size does not specify the size of the 
paper in the printer; Paper Size in the Set Up menu 
performs that function. 

To change the Scan Size setting: 

1 If necessary, select More from the Edit menu to display 
the Scan menu. 

2 Select Scan Size. 
3 From the Scan Size pop-up menu, choose a scan size by 

selecting the box next to the appropriate size: 

Letter for pages 8.5 inches by 11.0 inches 
Legal for pages 8.5 inches by 14.0 inches 
A4 for pages 8.3 inches by 11.6 inches 
Custom for pages whose size differs from the 

above three 
4 If you choose the Custom setting: 

o Select one of the arrows next to Custom Width until 
the width of the page in the scanner appears. 

o Select one of the arrows next to Custom Height 
until the height of the page in the scanner appears. 
Alternatively, select Custom Width (or Custom 
Height) and type the width (or height) of the page 
in the scanner. 

5 To update the Scan Size pop-up menu with this new 
information, select Go at the bottom of the menu. 
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Set Up Menu 

The Set Up menu (F3) presents several options that you 
can use to alter aspects of OFIS Imager. You can use this 
menu to: 
o change the function of the buttons on the mouse 

(Mouse Hand) 
o specify the size of the paper on which you want to print 

an image (Paper Size) 
o change the settings for resolution (X Resolution and 

Y Resolution) 
o alter the units of measurement on the rulers in the 

work areas (Units) 
o change the format that OFIS Imager uses to save 

images (TIFF File Format) 

For details on procedures, refer to related discussions in 
section 3 and information in this section under Mouse 
Hand, Paper Size, Resolution, Units, and TIFF File 
Formats. 

If you do not change any of the options in this menu, the 
following defaults occur: 
o Mark is the left button on the mouse 
o the image is set up to print on paper 8.5 inches by 11.0 

inches (letter size), unless an entry in the user 
configuration file is made to alter it 

o the rulers' units of measurement reflect inches 
o the printer you choose determines the resolution of the 

image 
o the images you save are compressed with the Pack Bits 

file format to occupy a minimum of disk space 

You can also change the defaults for all of the values in the 
Set Up menu by adding or editing appropriate entries in 
the user configuration file. 
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Single Layout 

When your OFIS Imager screen is in Single Layout one of 
the two work areas, either the Preview Work Area or the 
Final Work Area, is enlarged to fill the screen. This feature 
is useful when you want to see more of an image. 
OFIS Imager defaults to Dual Layout, the opposite of 
Single Layout, when both work areas display, unless you 
specify otherwise. 

You use the Layout icon, located at the top of the screen 
between the two picture tabs, to switch between Single 
and Dual Layout. 

To switch to Single Layout: 

1 While in Dual Layout, select the Layout icon. 
The active work area now occupies the entire screen. 

2 To display the other (non-active) work area, select its 
picture tab. 

3 To return to Dual Layout, select the Layout icon again. 
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TIFF File Formats 

TIFF File Formats are options in the Set Up menu. All 
images created by OFIS lmager are stored in Tagged 
Image File Format (TIFF), a standard file format for 
raster images. OFIS Imager offers three TIFF File Formats: 
o Pack Bits 
o CCITT3 
o Uncompressed 

Pack Bits and CCITT3 are compressed file formats. Pack 
Bits is the default setting, since it saves disk space by 
producing the smallest file (on average) of the three file 
formats. CCITT3 is a standard file format used primarily 
for FAX transfers. Other software packages besides 
OFIS Imager may support CCITT3 only. CCITT3 
compresses line art files only, not dithered images. The last 
option, Uncompressed, interchanges images created by 
OFIS Imager with other software packages that do not 
operate with compression. 

If you need to change the TIFF File Format, you should 
do so before you save an image. Since the command is in 
the Set Up menu, you specify the TIFF File Format when 
you set up OFIS Imager. 

To change the file format: 

1 From the Function menu, select Set Up (F3). 
2 Move the cursor to the desired TIFF File Format and 

click Mark. 
3 Select Go. 

The file is not actually saved until you issue the Save 
Image (F4) command from the Files menu. 
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Undo 

The Undo (F2) command reverses the results of the last 
Fill, Erase, Reverse, or Mirror edit command that you 
issued, provided you use Undo immediately (before you 
press any other key or select any other icon). Undo also 
reverses the last Scan Box size you determined. 
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Units 

Each work area has a ruler along the top and left side. At 
the start of each OFIS Imager session, the rulers' units of 
measurement is inches; you can use Units, accessed from 
the Set Up menu, to change the units to centimeters. 

The default rulers' units is inches. You can set the default 
to centimeters by specifying A4 as the Output Paper size 
in the user configuration file. Refer to appendix B for more 
information on user configuration file specifications. 

The placement of the markers for the units of measurement 
on the rulers changes when you magnify a work area with 
the Zoom In feature. 

To change the units of measurement in the ruler areas: 

1 From the Function menu, select Set Up (F3). 
The Set Up menu is displayed. 

2 Under Units, select Centimeters. 
3 Select Go at the bottom of the menu. 
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Unlock 

Unlock, one of the two options on the Quick menu (Lock is 
the other), frees the Edit Box after it has been locked into 
position during multiple edits. 

To unlock the Edit Box: 

1 Select the middle mouse button, or press CODE-M, to 
display the Quick menu. 

2 Select the Unlock icon. 

Alternately you can unlock the Edit Box by selecting the 
More icon and switching to the Scan menu. 

5029895 



4-58 Command and Function Reference 

Views 

OFIS Imager provides three different ways to look at an 
image in the active work area. These different views are in 
the Views menu. 

To change the view of an image in the active work area: 

1 From the Function menu, select Views (F6). 
2 Select a view from the following three possibilities: 

o Full Page, which displays the entire image in the 
active work area. 

o Full View, which displays the top part of the page 
in the active work area. 
In Dual Layout, Full View and Full Page display 
the same view. 

o Zoom In, which allows you to magnify a portion of 
the acive work area or image. 
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Zoom In 

Zoom In allows you to magnify a portion of the active 
work area or image. When you magnify part of an image, 
its details become larger and clearer, making it easier to 
edit. 

To use Zoom In: 

1 From the Function menu, select Views (F6). 
2 From the Views menu, select Zoom In. 

The Zoom In cursor is displayed with its associated 
Zoom Box. 

3 To resize the Zoom Box, press Bound and drag the 
mouse. 
Notice how the size and shape of the Zoom Box change. 
Use the markers in the ruler displays to determine the 
precise size of the Zoom Box you desire. 

4 To move the Zoom Box, move the mouse without 
pressing any buttons. 

5 When you have determined the area you want to 
magnify, click Mark. 
The area is magnified. If the image is in the Final Work 
Area, you can now apply any of the editing tools to the 
magnified portion of the image including Fill, Erase, 
Mirror, and Reverse. 
You can print the magnified portion of the image. Refer 
to the description of Print for details. 

6 To stop working in Zoom In mode and return the entire 
image to the screen, select Views (F6) again, and from 
there select Full Page. 
The image is displayed in its actual size. If you used 
any of the edit tools while in Zoom In mode, the portion 
of the image you modified reflects any changes. 

Note: If you select Zoom In again, after returning the entire 
image to the screen, the outline of the previous Zoom area is 
shown enclosed in a dotted box. 
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Error Codes and Messages 

This section lists error codes and messages, called status 
codes, for OFIS Imager. The error codes are listed in 
numerical sequence. The corresponding error messages are 
listed and followed by a brief explanation. Refer to your 
BTOS II System Status Codes Reference Manual for 
information on status codes not listed below. 

13401 

13402 

13403 

13404 

13405 

13406 

13407 
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Bad data was sent to the scanner. 

Command error. The last command sent to the scanner 
was not recognized. 

The scanner did not respond. 

The scanner failed to respond within a preset time to the 
last command. Check to see that the scanner is properly 
connected. 

Error received from the scanner. 

The scanner returns this error when no other error fits. 

Bad data was sent to the scanner. 

Format error. The last command sent to the scanner was 
not in the correct format. 

Bad parameter given to scanner. 

The last command sent to the scanner contained illegal 
parameters. 

Scan box is outside of the scan page. 

Some or all of the scanning window is outside the 
scannable page. 

Scanner cannot scale this amount. 

The scale factor is out of range. 
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13408 

13409 

13410 

Error Codes and Messages 

Scan page size is not within scanner capability. 

The size of the page you want to scan exceeds the 
scanner capabilities. 

Reserved. 

File is not a TIFF file. 

The picture file does not follow the TIFF format. 

13411-13412 

13413 

13414 

13415-13419 

13420 

13421 

13422 

13423 

Reserved. 

No image to save. 

There is no image in the Final Work Area to save. 

No preview file to get image from. 

There is no image in the Preview Work Area. 

Reserved. 

Operation can't be done with this scanner. 

This feature is not supported by the scanner defined in 
the user file. 

Unrecognized scanner type. 

The scanner listed in the user file is not recognized by 
OFIS lmager. 

No scanner is hooked up. 

There is no scanner listed in the user file. 

Reserved 
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13424 

13425 

Bad scanner configuration filename in user file. 

A bad scanner configuration file was given in the user file. 

BLP Server is not installed. 

The BLP Server needs to be installed to communicate to 
the scanner with the operating system installed on the 
system. 

13426-13452 

13453 

Reserved. 

Can't CCITT3 compress this image. 

Unable to do CCITT3 compaction on this file because it 
would generate a larger file than if saved uncompressed. 
TIFF format should be changed in the Set Up menu to 
Pack Bits or Uncompressed. 

13454-13490 

13490 

Reserved. 

This is not allowed in the Preview area. 

This operation is not allowed in the Preview Work Area. 
The operation is only allowed in the Final Work Area. 

13491-13492 

13493 

13494 
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Reserved. 

Cannot do this outside of the defined box. 

An attempt was made to perform an illegal operation in 
Exterior mode. For example, you can not mirror an image 
surrounding a defined box. 

Resolution differs: (xx, yy), preview first. 

You cannot scan this image directly to the Final Work 
Area because the output resolution and the image 
resolution are different. First scan the image to the 
Preview Work Area then to the Final Work Area or make 
the output resolution the same as the image resolution. 
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13495 

13496 

13497-13502 

13503 

Error Codes and Messages 

This isn't allowed outside of the Final work area. 

This operation must be performed in the Final Work Area, 
it cannot be performed in the Preview Work Area. 

This only applies to Photograph mode. 

Select Photo mode before trying to change this option. 

Reserved. 

Message is not in [sys)<sys>ScanMsg.bin. 

Invalid message. 
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User Configuration Files 

The User Configuration File identifies you as a user to the 
system and defines the application environment, the 
default volume and directory, and the messages displayed 
when you sign on to the system. OFIS Imager recognizes up 
to six entries in it's User Configuration file; these entries 
customize the environment of OFIS Imager. Such entries 
are described below: 
o Left-handed mouse functionality 

Mouse configuration defaults to right-handed use, but 
you can specify left-handed use by adding the 
following line in the User Configuration File: 
:LeftHanded:y 

o Mouse/cursor speed 
The speed of the cursor in relationship to how quickly 
you move the mouse defaults to a value of 4. You can 
change this setting in the User Configuration File by 
adding the following entry (or changing the number 
that follows the entry) shown below: 
:MouseSpeed:(l through 10) 
The higher the number you enter, the faster the cursor 
moves in relationship to the mouse. 

o Scanner information 
When a scanner is connected to a workstation, two 
entries must be made in the User Configuration File. 
These entries (listed below) inform OFIS Imager from 
where to scan files. 
:ScannerName:<scanner name> 
(The valid scanner names are HP9190 and MS300A.) 
:ScannerConfigFile: <configfile name> 
(The ScannerConfigFile name should be the one for 
the scanner specified in the Scanner Name entry.) 
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Following are sample User Configuration Files for the 
Microtek MS-300A scanner and the HP Scanjet scanner: 
:ScannerName: MS-300A 
:ScannerConfigfile: 
(Comm]A&(Sys)<Sys>SerialScanConfig.sys 

Note: [Comm]A in the Microtek ScannerConfigfile refers 
to the Comm port to which the scanner is connected. This 
entry will vary with different Comm ports. 

:ScannerName: HP9190 
:ScannerConfigfile: 
[LPT]&[Sys] <sys> ParallelScanConfig.sys 

o Default output information 
You can specify a default printer as well as a default 
output paper size using the User Configuration File. The 
appropriate entries for these specifications are: 
:IDDefaultPrinter:<printer name> 
:IDDefaultOutputPaper:<paper size name> 
If the latter entry is specified, then the paper name 
specified becomes the output paper size and also the 
scan size. If the entry is not specified, the overriding 
default is Letter. Other valid names are Legal and A4. 

Note: There is a scan size limitation if you are using the HP 
Scanjet scanner; it is the setting A4 (8.3 inches by 11. 7 inches) 
on the Scan Size pop-up menu. If you are using the Microtek 
scanner, you can scan up to the Legal setting (8.5 inches by 14 
inches). 

The Microtek scanner has a limitation in that you cannot enlarge 
an image scanned with the Microtek MS-300A scanner with the 
Change Size tool. The Microtek scanner indicates this by 
providing only five scan handles when you switch to the Change 
Size option. To increase the size of the irr1age beyond the 
hardware limit, save the image in a file and scan it in to your 
work area with the desired size. OFIS lmager scales an image to 
enlarge it. Scaling may result in some distortion of the image. 
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Configuring OFIS lmager with 
OFIS Designer 

B-3 

When you install OFIS lmager on your workstation, certain 
entries are created in either the Context Manager 
Configuration File or a Chaining Configuration File. 

Table B-1 contains information you need when configuring 
OFIS Imager with OFIS Designer. For more information on 
coordinating OFIS Imager with OFIS Designer refer to the 
BTOS OFIS Designer Installation, Configuration and 
Administration Guide . For steps on how to properly place 
a completed image in a document, refer to the BTOS 
OFIS Designer Operations Guide, Volume 3: Advanced 
Operations. 

Table B-1 Information for Configuring OFIS lmager 

Type of Information 

Command name 

Run file name 

:OFDObjectEdited: 

Requirement 

OFIS lmager 

[Sys]<sys>OFISlmager.run 

270 

Configuring Context Manager with 
OFIS lmager 

BTOS Context Manager II is BTOS software that lets you 
run several applications simultaneously so that you can 
switch back and forth between them. When configuring 
Context Manager, you provide information about the 
applications you want to run. 

Table B-2 contains information you need when configuring 
Context Manager to run with OFIS Imager. For an 
explanation of how to use this information, refer to your 
BTOS Context Manager Installation and Configuration 
Guide. 

5029895 



B-4 User Configuration Files 

Table B-2 Context Manager Configuration Requirements 

Type of Information Requirement 

Run file name OFISlmager.run 

Run file version 6 

Runs in Protected Mode yes 

Minimum memory required 500 Kb 

Able to be swapped yes 

Needs Executive screen no 

Loads own font yes 

Loads own keyboard translation no 
table 

Directly manipulates the video no 

:OFDObjectEdited: 270 
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Glossary 

Active. Active describes work areas and tools. An active work 
area is the one in which you are working; an active tool is the 
icon you are currently using to modify images. 

Active Work Area. The active work area is the work area in 
which you are currently working. 

Active Tool. The active tool is the icon you are currently using 
to modify images. 

Application. An application is a software program that accepts 
information as input, handles that input, and provides processed 
data as output. 

Arrow Keys. Arrow keys move the cursor in the direction of 
the arrow when the key is pressed. In OFIS lmager, this 
alternative to using a mouse requires you to hold the SHIFT key 
and press an Arrow key. 

Brightness. Brightness is a term for the relative presence or 
absence of shading. 

BTOS. BTOS is a Unisys workstation operating system. 

CCITT3. CCITT3 is a type of Tagged Image File Format (TIFF). 
It is a compressed file format used primarily for FAX transfers. 

Character. A character is any alphanumeric or punctuation 
symbol entered from a workstation's keyboard. 

Clear. To clear an image means to remove it from the work 
area display. 

Click. To click is the act of selecting an icon or function; the 
action requires you to press and release the Mark button on the 
mouse. 

Cluster Configuration. A cluster configuration is a local 
resource-sharing group of workstations consisting of a master and 
one or more cluster workstations. The operating system can run 
in each cluster workstation and in the master workstation. 

Cluster Workstation. A cluster workstation is connected to a 
master workstation within a cluster configuration. 

Command. A command is an instruction to the system to 
perform a specific action. 
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Compressed file. A compressed file is one that has been 
stored in such a way as to save disk space. 

Configuration. A configuration defines how a system or 
application works. It is a combination of hardware and/or 
software elements and their physical and logical relationships. 

Context Manager. Context Manager is a BTOS software 
program that allows several applications and/or utilities to run 
simultaneously. 

Cursor. The cursor is the symbol in the display which moves 
when arrow keys are pressed or the mouse is moved across a 
surface. 

Default. A default is an attribute to which OFIS lmager is 
already set. You can specify some defaults. 

Directory. A directory is where a group of files are kept; it is 
an area on your workstation's designated disk drive. 

Disk. A disk is a magnetic medium that stores electromagnetic 
signals. Your image files are stored on a disk, either a hard disk 
in your workstation or a flexible diskette, which you insert into the 
workstation. 

Disk Drive. A disk drive is the device that reads either hard or 
flexible disks. 

Diskette. A diskette is a reusable, flexible, magnetic storage 
device that records information. 

Dithered Images. Dithered images consist of black and white 
dots which are created by dithering technique. 

Dithering. Dithering is an image processing technique that 
allows you to produce images which appear to have continuous 
shades of gray on devices that support black and white (or green 
on a monochrome monitor). 

Dot. A dot, in OFIS lmager, is the smallest unit of 
measurement. A dot can be black, white or green. 

dpi. The letters dpi stand for dots-per-inch, which is used to 
measure the resolution of an image when it is displayed or 
printed. 

Drag. Dragging the mouse means moving or sliding it across a 
surface while pressing and holding down the Mark button. 

Dual Layout. The Dual layout allows you to see both work 
areas. 
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Edit Box. The Edit Box is used to define the part of an image 
you want to modify. 

Editing Modes. The OFIS lmager Editing Modes allow you to 
edit material inside (Interior Mode) or outside (Exterior Mode) the 
Edit Box. 

Editing Tools. The editing tools are used to alter images. The 
five OFIS lmager editing tools are called Fill, Erase, Reverse, 
Mirror Left-Right, and Mirror Up-Down. 

Edit Menu. The Edit menu is located on the right side of the 
OFIS lmager screen. You use it to modify images in the Final 
Work Area. 

Erase. To erase an image or edit area means to convert it to 
all white (or all green on a monochrome monitor). 

Error Message. An error message displays when the system 
cannot complete an operation. 

Executive. The Executive is the BTOS program that controls 
access to other applications and information on a workstation. 

Exterior Mode. The Exterior Mode is an OFIS lmager Editing 
Mode which allows you to edit outside the Edit Box. 

File. A file exists in a directory on a disk. When you file an 
image, OFIS lmager saves the edited contents for future 
retrieval. 

Fill. To fill an image or edit area means to convert it to all 
black. 

Final Work Area. The Final Work Area is the right work area 
when the OFIS lmager screen is in Dual Layout. This area 
contains the final image for output. The Final Work Area is the 
only work area where images can be modified or printed. 

Finish. To finish means to end an OFIS lmager session and 
either transfer your image to OFIS Designer or save it and exit 
the program. 

Floppy Disk. Floppy disk is a term that is synonymous with 
diskette. 

Function Keys. The function keys are located at the top of the 
keyboard (labelled Fl through FlO) and correspond to the 
Function menu in the OFIS lmager display. 
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Function Menu. The Function menu is located at the bottom 
of the OFIS lmager display; it shows the screen functions, 
pop-up menus, and a Help menu corresponding to the function 
keys on the keyboard. 

Generic Print System (GPS). The Generic Print System (GPS) 
is installed as a system service for OFIS lmager printing. GPS is a 
set of interrelated programs and library routines, which together 
provide device independence for printing and procedures for 
tracking and controlling hard-copy output in a BTOS network. 

GPS. GPS is an abbreviation for Generic Print System. 

Handles. Rectangular handles appear on the scan box. They 
are used to move, size, and shape the box. 

Icon. An icon is a symbol representing an OFIS lmager tool or 
function; for example, a chalk eraser is the Erase icon. 

Image. There are two basic types of OFIS lmager images: line 
art, with little or no shading, and photographs, which have 
continuous shading. 

Interior Mode. The Interior Mode is an OFIS lmager Editing 
Mode which allows you to edit material inside the Edit Box. 

Landscape. A landscape picture is horizontally oriented on a 
page when printed. 

Laser. During scanning, the Laser option simulates shading in 
such a way that the image prints out best on a laser printer. 

Laser Printer. A laser printer is a machine that forms images 
with a beam of light on a light-sensitive field and then transfers 
the images to paper one page at a time. 

Layout. The layout can be either Single, where one work area 
fills the display, or Dual, where both work areas are visible in the 
display. 

Layout Icon. The Layout Icon is the symbol, in the 
OFIS lmager display, that you select to see either one or both 
work areas. 

Line Art. Line art refers to images that are primarily black and 
white or green with little or no shading. 

Lock. To lock all or part of an image means to keep it as it is 
while editing other parts or images. 
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Master Workstation. The master workstation provides a file 
system, queue management facility, and other services for all 
cluster workstations that are connected to it. In addition, it 
supports its own interactive programs and application systems. 

Menu. A menu is a portion of the screen that contains icons or 
function labels. You select OFIS lmager functions from the menu 
options. OFIS lmager uses several menus, such as the Scan 
menu, Edit menu, and the Function menu. 

Mirror. To mirror all or part of an image means to duplicate it 
from top to bottom or left to right. 

Monochrome Monitor. A monochrome monitor is a special 
display device that displays a single color character set on a 
contrasting black background. 

Mouse. The mouse is a mechanical pointing device attached to 
the keyboard which allows you to move the cursor, select menus 
and functions, and use tools. 

OFIS Designer. OFIS Designer is a comprehensive document 
design application that enables you to merge text with 
OFIS lmager images. 

OFIS lmager. OFIS lmager is a software application that 
enables you to scan photographs, pictures, and other images in 
order to edit, print, or incorporate them into OFIS Designer. 

Operating System. An operating system is the software 
program that provides the computer's basic operating 
instructions. 

Output Device. An OFIS lmager output device refers to the 
printer you use to print an image. 

Overlay. Overlay refers to the method used to scan an image 
into the Final Work Area. The method you choose determines 
whether the scanned image will replace or combine with existing 
images. 

Pack Bits. Pack Bits is the default TIFF. It is a compressed file 
format that saves disk space by producing the smallest file (on 
average) of the three TIFF file formats. 

Path. A path is the specific node, volume, and directory (disk 
location) of your image files. 

Photocopy. In OFIS lmager, the Photocopy option simulates 
shading in such a way that it reproduces well on a photocopy 
machine. 
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Photograph. Photographs, in OFIS lmager, refer to images 
that contain continuous shading. 

Photo Mode. Photo mode refers to the various OFIS lmager 
options you can use to simulate the shading in photographs or 
colors in drawings, such as Photocopy and Laser. 

Picture Tab. The picture tab is the area, in the OFIS lmager 
display screen, that indicates the active work area and the name 
of the image or file contained in the work area. 

Pop-Up Menu. Pop-up menus are lists of additional options 
displayed after you select certain tools or functions. 

Portrait. A portrait picture is vertically oriented on a page 
when printed. 

Preview. To preview an image means to scan it into the 
Preview Work Area. 

Preview Work Area. The Preview Work Area is located on the 
left half of the workstation screen where you can temporarily view 
an image currently in the scanner. 

Raster Images. Raster images are the photographs and line 
art scanned, modified, and stored by OFIS lmager. 

Resolution. Resolution refers to the amount of detail used to 
display or scan an image. The higher the resolution, the more 
detailed the final image. 

Retrieve. To retrieve an image means to redisplay it for 
viewing or modification after it has been stored on a disk. 

Reverse. To reverse an image means to convert its black dots 
to white or green and vice versa. 

Ruler Display. The ruler display is a grid contained along the 
top and left side of the OFIS lmager work areas. You can use it 
to measure and position the cursor, Scan Box, Zoom Box, and 
Edit Box. 

Save. To save an image means to create a permanent record 
of it on the disk. 

Scaling. Scaling is the process by which the size of the image 
is changed to best fit the desired output resolution. 

Scan. To scan an image means to transfer it into a computer 
in electronic form. 

Scan Box. The scan box is an arrangement of rectangular 
handles used to position and size the images scanned. 
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Scan Menu. The Scan menu is located on the right side of the 
OFIS lmager screen. You use it to adjust the scanning 
environment and scan images. 

Scanner. A scanner is a piece of hardware used to scan an 
image in order to transfer it into a computer in electronic form. 

Select. To select means to move the mouse cursor to an icon 
or function key and click the Mark button. You do this in order to 
choose a tool, work area, image, or file name to activate it for 
use. 

Session. Session refers to the time spent working in an 
application, from start to finish. 

Shading. Shading is a term for the quantity of black mixed 
with a pure color. 

Single Layout. The Single Layout displays on of the work areas 
at a time. 

Standalone. A standalone workstation is one that uses its own 
hard disk for storage and system services. 

Status Code. A status code is an error message with an 
associated number. 

Tagged Image File Format. The Tagged Image File Format 
(TIFF) is a standard file format for raster images. Images created 
in OFIS lmager are stored in this format. 

.tif. When you save image files, the suffix .tif is automatically 
added by OFIS lmager to your image files. 

Toggle. Toggle describes the action of switching back and forth 
between two stable states. 

Tool Palette. The Tool Palette displays the tools used to create 
and modify drawings, text, and charts. A different tool palette is 
displayed for each of these three tasks. 

TIFF. TIFF is an abbreviation for Tagged Image File Format. 

Uncompressed. Uncompressed is a type of TIFF. It 
interchanges images created by OFIS lmager with other software 
packages that do not operate with compression. 

Unit. A unit in OFIS lmager refers to a segment of the ruler 
area at the top of the screen. 

Unlock. To unlock all or part of an image means to enable it to 
be edited after having been locked. 
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User Configuration File. The user configuration file identifies 
you as a user to the system and defines the application 
environment, the default volume and directory, and the messages 
displayed when you sign on to the system. 

View. The view is that portion of a picture you can see, which 
may differ depending on whether you display the Full Page, the 
top part only in Full View, or Zoom In for detail. 

Volume. A volume is a disk (hard disk or floppy disk) which 
contains directories where files are stored. 

Work Area. The work area is that portion of the display screen 
where you view and edit images. The two OFIS lmager work 
areas are the Preview Work Area and the Final Work Area. 

Workstation. The workstation is the display screen, central 
processing unit, and keyboard with or without local storage. This 
term describes any Unisys BTOS workstation such as B28, B38, 
and B39. 

Zoom Box. The Zoom Box is used to select all or part of an 
image for magnification. You can change the size and position of 
the Zoom Box; the smaller the Zoom Box, the more magnified the 
image. 

Zoom In. The Zoom In option allows you to magnify all or part 
of an image to view it in greater detail. 
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M 

Mail Notification, 3-8, 4-25 
Maintain Size, 4-26 
Mark, 4-27 
Master workstation, Glossary-5 
Memory Requirements, 1·3 
Menu, Glossary-5 
Mirror, Glossary-5 
Mirror Left-Right, 4-28 
Mirror Up-Down, 4-29 
Mirroring an image, 3-23 
Monochrome monitor, Glossary-5 
More, 4-30 
Mouse, Glossary-5 

installing and configuring, 2-2 
operating, 2-2 
terms, 2-5 
three-button, 2-4 
two-button, 2-3 
using the, 2-5 

Mouse Hand, 3-9, 4-31 

0 
OFIS lmager 

configuration files, 8-1 
editing images, 3-19 
finishing a session, 3-31 
hardware requirements, 1-2 
installing, 2-1 
memory requirements, 1-3 
menus, 3-5 
Overview, 1-1 
printing, 3-9, 4-40 
printing images, 3-28 
scanning, 3-10, 4-48 
scanning directly into the Final Work Area, 3-17, 4-50 
scanning into the Final Work Area, 3-15, 4-49 
scanning into the Preview Work Area, 3-10, 4-49 
screen, 3-3 
software requirements, 1-3 
starting, 3-1 
status codes, A-1 
using, 3-1 



OFIS lmager edit tools, 3-20 
OFIS lmager Menus, 3-5 

pop-up menus, 3-7 
Set Up menu, 3-9, 4-52 
Function menu, 3-5 

OFIS lmager screen, 3-3 
final work area, 3-4, 4-13 
layout icon, 3-4, 4-22 
picture tabs, 3-4, 4-38 
preview work area, 3-4, 4-39 

OFIS Designer, Glossary-5 
OFIS lmager, Glossary-5 
Operating system, Glossary-5 
Operating the Mouse, 2-2 
Output device, 4-32, Glossary-5 
Output Paper, 3-9, 4-33 
Overlay, 4-34, Glossary-5 
Overlay Modes, 3-15 

p 

Pack Bits, Glossary-5 
Path, Glossary-5 
Performing the Final Scan, 3-16 
Photo mode, 4-35, Glossary-6 
Photo Mode Setting, 4-36 
Photocopy, Glossary-5 
Photograph, 4-37, Glossary-6 
Photograph icon, 3-14 
Picture Tab, 3-4, 4-38, Glossary-6 
Pop-up menu, 3-7, Glossary-6 
Portrait, Glossary-6 
Preview, Glossary-6 
Preview Work Area, 4-39, Glossary-6 
Previewing Line Art, 3-12 
Previewing Photographs, 3-13 
Print, 4-40 
Print menu, 3-30 
Printing Images, 3-28 

Q 

Quick Menu, 4-42 

R 
Raster images, Glossary-6 
Reference Material, vi 
Related Product Information, vi 
Replace, 4-43 
Resolution, 4-44, Glossary-6 
Retrieve, Glossary-6 
Retrieving Saved Images, 3-26 
Returning to OFIS Designer, 3-31 
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Returning to the Executive or Context Manager, 3-32 
Reverse, 4-45, Glossary-6 
Reversing an image, 3-22 
Ruler Areas, 4-46 
Ruler display, Glossary-6 

s 
Save, Glossary-6 
Save Images, 4-47 
Saving Images, 3-25 
Scaling, Glossary-6 
Scan, 4-48, Glossary-6 
Scan and Edit Menus, 3-6 

the scan and edit menus, 3-5 
Scan Box, 3-15, Glossary-6 
Scan File, 4-49 
Scan icon, 3-13 
Scan Menu, Glossary-7 
Scan Size, 4-51 
Scanner, Glossary-7 
Scanner information, 8-1 
Scanning an Image into the Final Work Area, 3-15 
Scanning an Image into the Preview Work Area, 3-10 
Scanning Directly into the Final Work Area, 3-17 
Select, Glossary-7 
Selecting Tools and Functions, 3-7 
Session, Glossary-7 
Set Path menu, 3-28 
Set Up Menu, 4-52 
Shading, Glossary-7 
Single Layout, 3-18, 4-53, Glossary-7 
Size Modes, 3-15 
Software Requirements, 1-3 
Standalone, Glossary-7 
Starting OFIS lmager, 3-1 

from Context Manager, 3-2 
from OFIS Designer, 3-2 
from the Executive, 3-2 

Status code, G!ossary-7 

T 
Tagged Image File Format, Glossary-7 
Text Conventions, vi 
.tif, Glossary-7 
TIFF, Glossary-7 
TIFF File Formats, 3-9, 4-54 
Toggle, Glossary-7 
Tool palette, Glossary-7 
Two Work Areas, 3-4 



u 
Uncompressed, Glossary-7 
Undo, 4-55 
Unit, 3-9, 4-56, Glossary-7 
Unlock, 3-24, 4-57, Glossary-7 
User Configuration File, Glossary-8 
User Configuration Files, B·l 
Using OFIS lmager, 3-1 
Using Single and Dual Layout, 3-18 
Using the Mouse to Define, Position, and Size, 2-5 
Using the Set Up menu, 3-9 

custom height and custom width, 3-9 
mouse hand, 3-9 
output paper, 3-9 
TIFF file formats, 3-9, 4-54 
units, 3-9, 4-56 
x and y resolutions, 3-9 

Using Zoom In, 3-18, 4-59 

v 
View, 3-17, 4-58, Glossary-8 
Volume, Glossary-8 

w 
Work area, Glossary-8 
Workstation, Glossary-8 

x 
X Resolution, 3-9 
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·Errata Sheet 

Errata Sheet for document: 

BTOS OFIS Imagcr 
Operations Guide 
Relative to release level 1.0 
Form 5029895 
February 1989 

Note: This document had an errata sheet, form 
5029895-E01, in April 1989. This errata sheet update, form 
5029895-E02, is dated January 1990. 

Please add the following information to your copy of the 
manual described above. 

1 

••••••••••••••••••••••• page 1-2 ••••••••••••••••••••••• 

Under the Hardware Requirements heading, under the 
fifth bullet, add a reference so that the paragraph reads: 

The Microtek® MS-300A or Microtek MS-JI ... 

After the Microtek paragraph, add the following sentence: 

Refer to table 1-1 for MS-II cable assignments. 

Under the fifth bullet, add a reference that reads: 

The HP"' ScanJet or HP ScanJet Plus HP9195 ... 

After the ScanJet paragraph, add the following sentence: 

Refer to table 1-2 for HP9195 cable pin specifications. 

Under the fifth bullet, remove the Note and replace it with 
the following: 

Caution: OFIS tmager scanners require special cables; 
standard cables may not provide adequate grounding resulting 
in dirty scanned images or perhaps a workstation crash when 
the scan begins. 

5029895-E02 



2 Errata Sheet 

Under the seventh bullet, add the following description of 
graphics hardware: 

B25VGA 

includes the B25VG2 and B25VG4 graphic slices (if 
using a B28 or B38 workstation) 

includes the B25VG 1 or B25VG3 graphic cards (if using 
a B39 or B28EXP workstation) 

*******************"'*** page 1-3 **********************"' 
Under the Software Requirements heading, under the 
second bullet, add a reference so that is reads: 

... if using HP ScanJet or HP ScanJet Plus HP9195 
scanner 

At the end of the page, add the following tables: 

The Microtek MS-II cable (part number SN-25015) is 
available from lnmac®. At the MS-II scanner end, the 
serial cable male connector is a standard 
RS-232-C 25-pin D. 

Table 1-1 

Scanner 

2 
3 
4/5 jumper 
7 

Microtek MS-II serial cable pin assignments 

Workstation 

3 
2 
4/5 jumper 
7 



Errata Sheet 3 

••••••••••••••••••••••• page 1-3 ••••••••••••••••••••••• 

The HP ScanJet Plus HP9195 cable (part number SN-23578) 
is available from Jnmac. At the HP9195 scanner end, the 
parallel cable male connector is a standard Centronix. 

Table 1-2 HP ScanJet Plus HP9195 cable pin specifications 

Signal 
Pin 

DO 
D1 

D2 

D3 
D4 
D5 

D6 

D7 
GND 
GND 

GND 

GND 

Work­
station 
Pin 

1 
2 

3 
4 

5 
6 
7 

8 
9 
10 

11 

12 

N/C 13 

Scanner 
Pin Signal Pin 

2 STROBE 
3 GND 

4 LP ACK 
5 BUSY 
6 N/C 
7 READ 
8 DIRECTION 

9 LPNOPAPER 
LPSELECT 

21/22 PULLUP 
jumper 
23/24/25 N/C 
jumper 
26/27 GND 
jumper 

Work­
station 
Pin 

14 

15 

16 
17 
18 
19 
20 

21 
22 
23 

24 

25 

Scanner 
Pin 

1 

19/28/29 
jumper 
10 
11 

14/15 
jumper 
12 
13 

17 

At the bottom of the page, add the following sentence: 

lnmac is a registered trademark of Inmac in Santa Clara, 
California. 

••••••••••••••••••••••• page B-2 ••••••••••••••••••••••• 

For the sample User Configuration Files, no changes are 
required. These entries can remain the same even though two 
new scanners were listed on page 1-2. 
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